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Getting Started

About this Document

Welcome to the BDNA Data Platform Administrator Guide. The BDNA Data Platform™ is a browser-based application that
provides you with a convenient, centralized administrative interface, the Administration Console. You can use the
Administration Console to configure Technopedia Catalog™ settings, and to schedule, configure, and execute Normalize™
processes. You can also use the Administration Console to integrate normalized data into your existing workflow and
business processes.

Depending on your licensing, the BDNA Data Platform includes the following components:
® BDNA Normalize

® BDNA Technopedia Catalog

® BDNA Technopedia API™

Included with all instances of BDNA Data Platform:

® BDNA Data Platform Administration Console

Document Audience

This document is intended for people who are responsible for:

® Managing and/or monitoring BDNA Normalize processes, including creating new processes, scheduling the running of
processes, and viewing normalization results.

® Managing user access to BDNA Normalize.

® Managing and maintaining Technopedia Catalog settings.

Note « Information about the BDNA Technopedia API can be found in the BDNA Technopedia API Reference Guide.

BDNA Data Platform 5.5 BDNA-AG_550 Company Confidential 7



Chapter 1 Getting Started
About this Document

Recommended Preparation

® |Installation and configuration of the BDNA Data Platform
® |nstallation and configuration of your licensed components

® Setup of a BDNA Normalize user account

Accessing the BDNA Data Platform Console

The BDNA Data Platform Console supports the following browsers:
® Windows Internet Explorer™ v11 or later
® Google Chrome™ v44 or later

® Mozilla Firefox™ v37 or later

Task To access the BDNA Data Platform Console:
1. Click the BDNA Data Platform icon. This action opens a web browser to:
® [fusinglIS: http://ipaddress/bdna-admin/Admin.aspx
® |fusing IIS Express: http://ipaddress:port/Admin.aspx

where ipaddress is the IP address or host name of the BDNA Data Platform Administration Console server, and port is
the port number you specify during configuration.

2. Enterthe login username and password you specified during installation. The Administration Console splash screen
opens.

Figure 1-1: Admin Console login screen (LDAP/AD user)

Admin Console

WBLAdmsnistrator

Figure 1-2: Admin Console login screen (local user)

8 Company Confidential BDNA-AG_550 BDNA Data Platform 5.5
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About this Document

Windows Security ,

iexplore.exe
Connecting to 192,168.10.72.

| Aadministrator |

Domain: NICOSIA
[ | Remember my credentials

(0].4 | | Cancel

Note « By default, only the user who installed BDNA Data Platform can initially login to the Administration Console.

Figure 1-3: Administration Console Splash Screen before a Normalize process is created

W e e

B DNA _r:l :._ s ‘ Ll Logge SRTLS 22T P

Normalize DEcemepiocess SN ey 2
Create, schedule, and run processes

Lrente & Normalize process
For wore haelp

B0, Data Platfiorn takes dala frem multiphe data scunces and maps 1L 10 a commeon kentity using Technopetea Cataleg, Afer Btenng fe
emaove displicalies and resohae conlicls, the dala s ennched with manke] inteliigence, resulting in dala that s consisten, chean and

Drawer  complete.
Mavigatien
Synchronize Catalog Results and Stats
Refresh e Technopedia Cataiog with Analyze the normaized data
e Exlest updates
=

(@ 11!

h
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Chapter 1 Getting Started

About this Document

Using the Administration Console

Once you add a process to BDNA Normalize, the Administration Console splash screen is replaced by the BDNA Normalize
main screen, an example of which is shown in BDNA Normalize Console Panels. This screen is divided into the following
panels:

10

Data source: Use this panel to add a data source to a process. Added data sources will display in this panel, as well as
groupings of combined data sources that share schedules and other settings.

Process: Use this panel to either run a BDNA Normalize process on demand or to schedule the process to run at a later
time.

Results: Use this panel to view statistics and access results of your most recent normalization.

Figure 1-4: BDNA Normalize Console Panels

=2 ACME-T S
DR oA RORRLIL N MBATE
5 ACMEJT F _ iz -8 m1
Mot Scheduied L ]
= ’
Ve osR DDsOE DR
Em *
EX Ao Data Sousee
Data Source Process Results
ACTRATY  LAET Meiay EATIM: WTROIT i

You can view additional information about Data Source, Process, and Results by clicking the Details icon above the
Results panel, as shown in the following image:

Figure 1-5: Details Information

=5 ACMEAT

cara ponmey AL T AT

= scuear » P Resuss 1w 23 Secmme
) DATA SELC TN
S

12:1

Pricay 1
Somrce HESCL_SBI01R4T

S s

Do Nak Schedule
= weun # ® Srmphe Schedule

Recwr every (30 ] -

Py 1
Soutee: Tl _ HPUOLD

= # Actvanced Schedule »

Pricey 3
Sometce Tmae . HRLCY

£E Acd Data Source

T pamaeemaE

ACTRATY  LAST NOfmie (FaTin SOR001T 9-00 Al

Note - Platform Ul detects the configuration file (Norm.Configuration.config) to see if Tier 1 & 2 software statistics are
turned on or off. By default, it is set to ‘false.” Hence, users do not see Normalize statistics on Admin Console page.
Customers can still turn this functionality on by editing Norm.Configuration.config and setting values for
"StatsKeywordExec" and "StatsKeywordAddremove" to ‘true’ if they want to see Tier 1 & 2 software statistics on both the
Normalize Results section of the Admin Console page and the Full Statistics pop-up window.
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Using Drawer Navigation

The Drawer Navigation, which is accessed by clicking the blue arrow located on the left-side of the Administration Console
screen, provides a menu of the following BDNA Normalize features and functions:

BDNA Data Platform 5.5

Normalize: Access the main screen of BDNA Normalize.
Technopedia: Access the Technopedia Catalog screen.
Security: Add, modify, or delete a security role assignment.

Preferences: Register your BDNA Data Platform key, enable access to an installed instance of BDNA Analyze, and/or
enable LAN proxy settings.

Activity Monitor: View information about BDNA Normalize processes and Technopedia Catalog synchronizations. For
more information.

Terms and Conditions: View licensing terms and conditions.
About: View Catalog, application version numbers, and copyright information.
Contact: View BDNA contact information.

Figure 1-6: Drawer Navigation Menu

MNormalize

Technopedia

:Ccurity

Preferences

Activity Monitor

BDNA-AG_550 Company Confidential 11
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About this Document

Creating a Process—General Overview

A process consists of one or more data sources that are configured to work with BDNA Normalize. You can add multiple
processes to BDNA Normalize. When you add a process, you proceed through a series of configuration screens that pertain
to the process type and data source.

To create a process:

1.

12

Click Create Process in the upper-right of the screen, as shown in Fig 1-7: Create Process.

Figure 1-7: Create Process

T T . VM1 B2W\Administrafor Logout
i 2 Last Login: 81072015 1:42 PM

EE Create Process EE Inventory

The Process Type screen opens, as shown in the following image:

Figure 1-8: Process Type

Create Process

Process Type

Select Process Type

-

= [T Discovery Tool
= Confightgr, Altirs, DDMI, etc..,

O = Purchase Order
= COW, Insignt, SHI, ete.

O Normalize CM
Poputate Confightgr database with normalized data

0 B Fingerprints
Extend capabiiies of existing discovery tool

Note « BDNA Data Platform Normalize CM process is no longer available.

Company Confidential BDNA-AG_550
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Setting Preferences

The Preferences screen, which is accessible through the console screen, lets you set preferences for:
® Registering an Activation Key

® Enabling Access to the BDNA User Console

® Enabling LAN Proxy Settings

® Enabling LAN Proxy Settings

Task To access the Preferences screen:
1. Click the blue “gear” icon located on the upper-right of the console screen.

2. The Preferences screen (Fig 2-9: Preferences—Registration) opens to show current status and information about your
registration.

Registering an Activation Key

Follow these instructions if you purchased any of the components of the BDNA Data Platform and need to update your
current activation key.

Task To register or update an Activation Key:
1. Open the Preferences screen. By default, it opens to the Registration tab.
2. Click Register New Key.

3. Enteryour company name in the Company Name entry field.

BDNA Data Platform 5.5 BDNA-AG_550 Company Confidential 13



Chapter2 Setting Preferences
Registering an Activation Key

Note « Enter your company name exactly as it is appears in the license key section of your Welcome Email in the
Company Name entry field.

4. Copy the activation key that you received from BDNA and paste it into the Activation Key entry field.
5. Click Register.

Figure 2-9: Preferences—Registration

BDNA

Preferences
Registration BDMA User Console LAMN Settings

Time Period Expir

Company Name Ct

| Tel

Activation Key

BDNA Data Platform

Start Date: 2015/06/25 00:00:00

End Date: 2016/06/26 00:00:00

Component: BDNA Normalize

Options: EDNA Analyze, SSRS, Excel with FowerPivot, CSV Files,
Normalize Features: [T Discovery Tool, ize CM, Fi ints, P €

Enabling Access to the BDNA User Console

Use this page to activate and enable access to an installed and configured BDNA User Console. Enable access to the BDNA
User Console server by entering the credentials (Local Users or LDAP/AD) you used in the BDNA Data Platform
Configuration Wizard.

Task To enable access to BDNA User Console:
1. Open the Preferences screen.
2. Click the BDNA User Console tab.
3. Provide the following settings for BDNA User Console:
® Activate BDNA User Console—Check the box to activate your installed and configured BDNA Analyze.
® BDNA User Console Server—Enter the server name or IP address of your BDNA User Console server.
® User (domain\username)—Enter the domain and username for the BDNA User Console server.

® Password—Enter the password for the BDNA User Console user.

14 Company Confidential BDNA-AG_550 BDNA Data Platform 5.5



Chapter2 Setting Preferences
Registering an Activation Key

4. Click Test Connection to verify your connection parameters.
5. Click Save.

Figure 2-10: Preferences—BDNA User Console
Preferences
Registratien ~ BOMA Uzer Conzole  LAN Setlings
Enable access to the BDMA User Console server. Enter the same credentials you used in the User Console Configuration Wizard.

[ Activate BDMNA User Console

BDMA User Console Senver:

I USElfdorainlusarmans).

Password:

sme.
Enabling LAN Proxy Settings

If required, you can configure your LAN proxy server information. All communications outside the company network will
pass through the specified proxy server.

Task To enable proxy settings:
1. Open the Preferences screen.
2. Click the LAN Settings tab.
3. Place acheck next to Use automatic configuration script to use a script that contains pre-defined proxy settings.
4. Enterthe location of the configuration file in the Address text box.
5. Place a check next to Proxy Server to manually enter the location and port number of the proxy server you want to use.

6. If necessary, enter the credentials required to access the proxy server.

BDNA Data Platform 5.5 BDNA-AG_550 Company Confidential 15
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7. Click Save.

Figure 2-11: Proxy settings

BDNA

Preferences

Regictration BORA Usar Consobe L&k Sattimgs

Local Arca Motwork (LA&N) Scitings

Proxy setlings
L] Use aamomatic configuraton script

[0 Prowy server
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Managing Security Settings

By default, only the person who installed and configured BDNA Data Platform can access the Administration Console. That

person can then add or delete additional Windows groups and users who can access the Console, by using the Console’s
Security screen.

Accessing the Security Screen

To access the security screen, do the following steps:

1. Click the blue arrow located on the left-side of the main Administration Console. The Drawer Navigation menu opens.

2. Click Security. The Security screen opens to show current status and information about your registration.The example

(Fig 3-12: Security) shows the User (domain\administrator) and the BDNA Data Platform Administrator role assigned
to the user.

Figure 3-12: Security

VM192Whdminisirator Logout
B D N A ﬂ l Last Login: 8/12/2015 8:15 PM
S ecu rlty "= Role Assignment EE Delete Selecied ?
Manage Role Assignment
(a
] Group or User Type Role(s)
O Edit VM192Wh\Administrator User T

BDNA Data Platform 5.5 BDNA-AG_550 Company Confidential
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Chapter 3 Managing Security Settings

Accessing the Security Screen

Adding a New Role Assignment

=
Task To add a new role assignment do the following steps:
1. Open the Security screen.
2. Click Role Assignment. The New Role Assignment dialog opens as shown in New Role Assignment.
3. Provide the following information:
®  Group or user name—Type a Nnew group or user name.
® Role: Select arole to assign to the group or user, from the following options:
e Platform Administrator:
®  Modify Security and Registration settings.
® Execute and schedule Catalog Synchronization.
® View and modify Catalog settings.
® Execute and schedule Normalize processes.
® Modify Normalize settings.
® Platform Read Only:
® Read-only access to view defined Normalize processes and corresponding statistics.
® User Console Report Manager:
® Manage all private and public reports.
® Search and browse Technopedia data, as well as Normalize data when available.
® (Create and share reports.
® User Console Editor:
®  Overwrite values for existing Technopedia attributes and create new Private Catalog entries.
® Define Private Software mappings for Private Catalog.
® Search and browse Technopedia data, as well as Normalize data when available.
® (Create and share reports.
® User Console Viewer:
® Search and browse Technopedia data, as well as Normalize data when available
® (Create and share reports
18 Company Confidential ~ BDNA-AG_550 ~ BDNA Data Platform 5.5



Chapter 3 Managing Security Settings
Accessing the Security Screen

4. Click Save.

Figure 3-13: New Role Assignment

New Role Assignment ?
Use this page to define role-based security for Normalize.

Group or user name: |

= Platiorm Administrator -Modify Security and Registration settings.
-Execute and schedule Catalog Synchronization.
Miew and modity Catalog setSngs.
-Execule and schadule Normalize processes.
Modify Mormalize setings.

Platiorm Read-Cnly -Read-only access o view defined Mormalize processes and corresponding statistics.

i« User Consale Report Manager Manage all private and public Reparts.
-Search and browse Technopedia data, as well as Mormalize data when available.
-Craake and shane Reports,

I User Console Editor -Ouerarite values for existing Technopedia attributes and create new Private Catalag entries.
-Define Private Software Mappings for Private Catalog.
-Search and browse Technopedia data, as well as Mormalize data when available.
-Create and share Reports.

I User Console Viewer -Search and browse Technopedia data, as well as Normalize data when avallable.
-Create and share Reports,

Deleting a Role Assighment

Task To delete a role assignment do the following steps:
1. Access the Security screen.
2. Click the checkbox next to the Group or User that you want to delete.
3. Click Delete Selected, located in the upper right of the Security screen. A Confirmation dialog opens.

4. Click OK to confirm your request to delete the role assignment.

BDNA Data Platform 5.5 BDNA-AG_550 Company Confidential 19



Chapter 3 Managing Security Settings
Accessing the Security Screen

20 Company Confidential BDNA-AG_550 BDNA Data Platform 5.5



Configuring Technopedia Catalog
Synchronization

About Technopedia Catalog Synchronization

BDNA Normalize uses Technopedia Catalog to clean and enrich your data. The Technopedia Catalog is the world’s largest
categorized repository of information about enterprise software and hardware.

Since Technopedia Catalog is updated on a daily basis, it isimportant to synchronize your Technopedia Catalog with the
latest iteration of Technopedia Catalog to ensure the best results when normalizing your raw data. There are two options
for synchronizing the Technopedia Catalog:

® Synchronizing Online

® Synchronizing Offline
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Accessing the Technopedia Catalog Synchronization Settings

Task To access the Technopedia Catalog Synchronization Settings, do the following steps:

1. Click the Technopedia Catalog icon on the BDNA Data Platform main page. The Technopedia Synchronize and
Schedule Catalog page opens (Technopedia Catalog Synchronize and Schedule).

2. Click Settings, located in the upper-right corner of the page. The Technopedia Catalog Settings page opens (Catalog
Settings — Online Synchronization).

Figure 4-14: Technopedia Catalog Synchronize and Schedule

) VM{D2WiAdministrator Logout
BDNA N (I Y et Login, 015518 ot
Technopedia EE st 7
‘Synchronize and schedule catalog
Not Scheduled
@ Do Not Schedule
O Simple Schedule
I Recur every [1
L © Advanced Schedule &+
<

Synchronizing Online

If the BDNA Data Platform Server is connected to the Internet, you can enable online, automatic synchronization of the
Technopedia Catalog.

Task To enable online synchronization:
1. Open the Technopedia Catalog Synchronization page.

2. Click Settings, located in the upper-right of the page.
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3. Click the Online Synchronization radio button (Catalog Settings — Online Synchronization).

Figure 4-15: Catalog Settings — Online Synchronization

Technopedia™

Catalog Settings
Synchronization ~ Web server  Lifecycle

(® Online synchronization

¥ Automatic catalog download

¥ Automatic software updates

Feedback

[l Automatic upload of Normalize unmatched data

[] Automatic upload of Normalize statistics data

File location on Normalize Server (disk space: 61,614 MB)

i workFolder

() Offline synchronization

Save and Synchronize ~ Cancel

4. Click one or more of the following checkboxes, as appropriate to your situation:

a. Automatic catalog download — Enables automatic download of any Catalog updates. If this is a first-time
download, then the entire Catalog will be downloaded.

b. Automatic software updates — Enables automatic download of software updates to Technopedia Catalog. If a
new update is available, a banner will display on the main screen of the Administration Console.

c. Automatic upload of unmatched data — Enables automatic sending of unmatched normalized records to BDNA,
as part of the synchronization process. If you select this option, you will need to either accept the default File
Location path and folder or enter information for a new path and folder. Any unmatched data will be generated in
the specified folder, uploaded to BDNA during synchronization, and then added to the Catalog using the BDNA
“gap-fill” process. See (Fig 4-16 BDNA Gap-Fill Process) for more detailed information.

d. Community Normalize Statistics Sharing - Customers can now share anonymized normalize statistics within the
BDNA community. An optional checkbox has been added on the Technopedia Catalog Settings that enables
customers to upload statistical unmatched data. All data is secure and encrypted. This data allows BDNA to
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optimize Technopedia content refreshes by better understanding inventory data used across our customer base

at an aggregate level.

Figure 4-16: BDNA Gap-Fill Process
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5. Click Save and Synchronize to save your settings and begin synchronization.

Note - Ifyou enable Online Synchronization, you can also specify when to run the synchronization.

Synchronizing Offline

If your BDNA Data Platform Server does not have an Internet connection, you can update the Technopedia Catalog by
downloading the latest iteration of the Technopedia Catalog to an Internet-connected machine, copying the downloaded
files to the BDNA Data Platform Server, and then uploading those files to the BDNA Data Platform.

24

Synchronization behavior is slightly different when the Data Platform server has TLS 1.2 enabled. On the Synchronization
page of the Admin Console, after the user clicks Start Synchronization, a download dialog window pops up, which will

automatically dismiss itself.
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Also in the BDNA.log, the following exception will be logged: "INFO System.Net.WebException: The underlying connection
was closed: An unexpected error occurred on a receive. ---> System.ComponentModel.Win32Exception: The client and
server cannot communicate, because they do not possess a common algorithm".

These are known limitations that do not affect functionality, and will be addressed in the future releases.

Task To synchronize the Catalog offline:
1. Open the Technopedia Catalog Synchronization page.
2. Click Settings, located in the upper-right of the page. The Technopedia Catalog Settings page opens.
3. Click the Offline Synchronization radio button (Technopedia Catalog Settings — Offline Catalog Synchronization).

Figure 4-17: Technopedia Catalog Settings — Offline Catalog Synchronization

Technopedia™ s

Catalog Sattings
Synchroniration Vieh sarver Lifacycha

71 Ondine synchranlzation

‘® Offfine synchronization

o Automatic software updates

Download address:
hittp:/ (tuss o bdna oo/ GetOfLine UpdatedFile_aspy? requestinfo=efudksmOma AQR 6 fFWarll -

Upload cataloeg

Upload catalog fo install

4. Copy and paste the information in the Download Address field into the address field of an Internet-connected
browser. This will enable you to manually download the Technopedia Catalog to the BDNA Data Platform server.

v

Copy the downloaded files to the BDNA Data Platform server.

6. Click the Upload Technopedia Catalog button and specify the path to where you copied the Technopedia Catalog files.

7. (Optional) Click the checkbox for Automatic updates. This enables the automatic download of software updates. If a
new update is available, then a banner will display on the main screen of the Administration Console.
8. Click the Save and Synchronize button.

BDNA Data Platform 5.5 BDNA-AG_550 Company Confidential 25



Chapter 4 Configuring Technopedia Catalog Synchronization
Synchronizing Offline

Configuring Additional Technopedia Catalog Settings

There are additional settings for configuring the Technopedia Catalog. These include settings for the type of web server
access, and settings for flagging hardware and software products for End-of life (EOL) status.

Web Server Settings

On the Web Server tab, you can specify the type of Web Server connection to Technopedia, by completing one of the
following steps.

® Toenable an SSL (HTTPS) connection, click the Enable SSL(HTTPS) radio button and specify the port, (port 443 is the
default).

® Toenable an HTTP connection, click the Enable HTTP radio button and specify the port, (port 80 is the default).

Figure 4-18: Web server settings

Technopedia™ 7 Q

Cataicg Seliings

Synchronization  Web server  Lifecyde

Web server connection
® SSL(HTTPS) connecliens on port: 449
3 HTTP comnections on port: Bo

Lifecycle Settings

BDNA Normalize flags End-of-life data whenever it is available from the manufacturer. However, when End-of-life data is

not available, Normalize uses industry-wide averages obtained from Technopedia to infer whether support is still available
for a product.

On the Lifecycle tab, you can enable flagging of software and hardware products that have reached their End-of-life dates.
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If the Software or Hardware product lifecycle has exceeded the industry-wide average number of months provided for
support, it is assumed to be no longer supported. Place a check in the “Lifecycle” checkbox to flag these products.

Additionally, if the Software product's number of version increments exceeds the industry-wide average for number of
version increments maintained under support, it is assumed to be no longer supported. Place a check in the “Version
increments” checkbox to flag these products.You can accept the default values BDNA provides in this dialog, or you
can specify custom values for lifecycle duration and number of version increments.

Figure 4-19: Lifecycle tab

Technopedia™ 2 €

Calalog Seftings

Synchronization Web server Lifecycle

SOFTWARE: Place a check in the "Lifecycle” checkbox andior the "Wersion increments” checkbox to flag products that are no
longer supportad. HARDWARE: Flace a check in the "Lifecycle” checkbox to flag products that are no lenger supported.

¥ SOFTWARE:

¥ Lifecycle
® Industry average a7 monihs
21 Custom | a7 E months
W] Version increments
®) Industry average 7 VETEIons
) Caustom | - E versions
M HARDWARE:
[ Lifecycle
® Industry average 99 monihs
1 Custom | o E months
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Synchronizing the Technopedia Catalog

If you configured the Technopedia Catalog for online synchronization, you can specify when to run the synchronization.
You can choose from the following options to synchronize the Technopedia Catalog:

®  Synchronizing On Demand
® Scheduling a Simple Synchronization
® Scheduling a Weekly Synchronization

®  Scheduling a Monthly Synchronization

Accessing the Technopedia Catalog Scheduling
Screen

Click the Technopedia Catalog icon, located in the upper-right corner of the Administration Console. The Technopedia
Synchronize and Schedule Catalog page opens and shows the time of the last catalog synchronization (see Technopedia
Synchronize and Schedule Catalog page).

Figure 5-20: Technopedia Synchronize and Schedule Catalog page

VMBI Administrato
Last Login: 8102015 5:10 PM

1z
-

BDNA

Technopedia

‘Synchronize and schedule catalog

= Settings 7

Not Scheduled

® Do Not Schedule

I O Simple Schedule

Recur every [1
t © Advanced Schedule *
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During synchronization, a progress bar is displayed below the Start Catalog Sync button (see Fig 5-2: Synchronization
Progress). For more details about the synchronization status, open the Activity Monitor screen.

Figure 5-21: Synchronization Progress

Start Catalog Sync

ACTIITY I UPDATER: FROCESSIMG CATALOG LIPDATE. ..

Synchronizing On Demand

Task To synchronize on demand, do the following steps:
1. Open the Technopedia Synchronization and Schedule Catalog page.

2. Click the “Start Catalog Sync” button to begin the synchronization process.

Scheduling a Simple Synchronization

Use a simple schedule to synchronize the catalog at recurring intervals that correspond to days, weeks, or months.

g

Task To set up a simple schedule:
1. Open the Technopedia Synchronization and Schedule Catalog page.
2. Select the Simple Schedule radio button.

Figure 5-22: Simple Synchronization Schedule
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L Mot Scheduled

" Do Mot Schedule

& Simple Schedule

Recur every |1 | Day(s) =l

© Advanced Schedule

oy
3

Cancel

3. Choose one of the following options from the dropdown list:

® Days
® Weeks
® Months

4. Enter an appropriate value in the entry field:
® Days1-31
® \Weeks:1-4
® Months: 1-12

5. Click Save.

Scheduling a Weekly Synchronization

Task To schedule a weekly synchronization, do the following steps:
1. Open the Technopedia Synchronization and Schedule Catalog page.
2. Select the Advanced Schedule radio button. The Advanced Schedule dialog opens.

Figure 5-23: Weekly Schedule
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Advanced Schedule

Start Date Start Time

Recurrence Pattern

Recur every I I Waeks |

[T Sunday [~ Monday [T Tuesday [~ wWednesday [~ Thursday
[T Friday [T Saturday
C!Kl Cancel

3. Click the Start Date entry field to choose a date from the selection calendar.

4. Click the Start Time entry field to choose a time from the time list.

5. Enter a number in the Recur Every entry field. The Values are 1-4.

6. Select Weeks from the dropdown list.

7. Select checkboxes for each day in the week that you want to synchronize Technopedia Catalog.

8. Select checkboxes for all days in the week that you want to synchronize the catalog.

For example, to synchronize the catalog every Monday and Thursday, enter 1 in the Recur every entry field and place

checks in the Monday and Thursday checkboxes.
9. Click OK.

Figure 5-24: Custom Schedule Information

& Advanced Schedule

Dccurs every 1 week(s). Effective 57212014 1:00am.
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Scheduling a Monthly Synchronization

Task To schedule a monthly synchronization, do the following steps:
1. Open the Technopedia Synchronization and Schedule Catalog page.
2. Select the Advanced Schedule radio button. The Advanced Schedule dialog opens.

Figure 5-25: Monthly Schedule

Advanced Schedule 7.

Start Date Start Time
/2172014 |1:00am

Recurrence Pattern

Recur every |1
€ On Da*_.,.fh

" Last Day of the Manth

E

Months

© The I First =] I Sunday 4

OK Cancel

3. Click the Start Date field to choose a date from the selection calendar.
4. Click the Start Time field to choose a time from the time list.

5. Enteranumberin the Recur Every entry field. The values are 1-12.

6. Select Months from the dropdown list.

7. Complete the steps for one of the following options.

a. Tosynchronize the Catalog on a specific day of the month: Click the On Day radio button and enter a value in
the Day field. Values can be any whole number between 1 and 31.

b. To synchronize the Catalog on the last day of the month: Click the Last Day of the Month radio button to
schedule Normalize to run on the last day of the month.

c. Tosynchronize the Catalog on a specific day according to its location on the calendar, complete the
following steps.
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1. Click the bottom radio button.
2. Select aavalue from the Frequency drop-down list. The values are First, Second, Third, Fourth, Last.

3. Select avalue from the Day drop-down list. The values are Sunday, Monday, Tuesday, Wednesday, Thursday,
Friday, Saturday, Sunday.

For example, to synchronize the Catalog on the third Saturday of every month, choose Third and Saturday.
8. Click Save. The Advanced schedule status is displayed in the Details panel.

Figure 5-26: Monthly Advanced Schedule Status

® Advanced Schedule 4

Docurs every T monthis). Effective 5/21/2014 1:00am.
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Creating an IT Discovery Tool Process

Use this process to normalize data from an IT Discovery Tool. Creating a BDNA Normalize process on the Administration
Console is a multi-step configuration process that may vary slightly depending on the type of IT discovery tool you are
adding.

There are two main steps for creating an IT Discovery Tool process:
® Configuring IT Discovery Tool Data Source Settings

® Configuring IT Discovery Tool Process Settings

Configuring IT Discovery Tool Data Source Settings

There are three types of data sources that you can use to create an IT Discovery Tool process: database, ServiceNow, or
BDNA Normalize zip file. Instructions for configuring the process with each type of data source can be found at:

® Using a Database Connection as a Data Source
® Using ServiceNow as a Data Source

® Using a Normalize Zip File as a Data Source

Using a Database Connection as a Data Source

Task To configure a database connection:

1. Click Create Process, located in the upper-right section of the Administration Console. Click the IT Discovery Tool
radio button.

2. Click Next.

3. Select the IT Discovery tool that you want to normalize. The discovery tools are listed in alphabetical order and may
require scrolling the window to see the entire list.
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Note « BDNA highly recommends that the database user account used to extract data from a data source is a read-only

account.

Note  These instructions do not apply to either the ServiceNow or Other: Normalize Zip file data sources. Instructions for

those data source options are provided in Using ServiceNow as a Data Source and Using a Normalize Zip File as a Data

Source

Figure 6-27: Selecting an IT Discovery Tool—Database Connection

Create Process

Process Type > IT Discovery Tool

Select IT Discovery Tool

Select a discovery tool you want to normalize.

(®) Altiris 7.0 Client Management Suite

() Adtiris 7.1 Client Management Suite or higher

() Altiris Client Management Suite 5 and 6
(O Altiris Express

() ASG Trackbird

(C) BONA Discover

() BMC ADDM

() BMC BladeLogic Client Automation

(C) BMC BladeLogic Server Automation

(0) CA IT Client Manager (ITCM)

() CiscoWorks LAN Management Solution (LMS)

() Dell KAGE

() HP Client Autormnation
() HP DDMI

() HP DDMa

(O HP Server Automation

4. Click Next. The Select Data Source screen opens.

() IBM Tivoli Asset Discovery for 208

() 1BM Tivoli Endpoint Manager

() JAMF Casper

(O Lakeside SysTrack

() LANDesk

() Lansweeper

() ManageSoft Enterprise Compliance Manager (ECM)
() Microsoft Assessment and Planning Toolidt (MAP) 7
() Microsoft Assessment and Planning Toolkit (MAP) 8
() Microsoft SMS 2003

(O Microsoft System Center Configurafion Manager 2007
() Microsoft System Center Configurafion Manager 2012
(3 Novell ZENworks

D ocs

() Scalable

(O VMware vCenter Protect

5. Click the database connection radio button that is applicable to your situation. Options are determined by the IT

Discovery Tool selected in Select the IT Discovery tool that you want to normalize. The discovery tools are listed in
alphabetical order and may require scrolling the window to see the entire list. and type of database used by BDNA

Normalize.

6. Select a configuration file (or use a customized configuration file), for the discovery tool you are adding.

7. Ifyou are using a Normalize 4.x customized configuration extractor file, you must convert the file to BDNA Data

Platform format.

8. Enter configuration values for the discovery tool’s data source and location.

Note « The specific fields that display on the screen will vary, depending on the database connection previously selected. See

IT Discovery Tool Data Source—MSSQL (MSSQL), IT Discovery Tool Data Source—QOracle (Oracle), IT Discovery Tool Data

36
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Source—DB2 (DB2), IT Discovery Tool Data Source—MySQL (MySQL), IT Discovery Tool Data Source—PostgreSQL (PostgreSQL),
or IT Discovery Tool Data Source—Sybase (Sybase) for details about each of the database configuration fields.

9. Click Test Connection to verify the connection.
10. Complete one of the following options:

® To configure the Process Settings now: Click Next and go to Configuring IT Discovery Tool Process Settings for
detailed instructions.

® To configure the Process Settings later: Click Finish to add the process to the Administration Console. You can
complete the additional process settings at a later time.

Figure 6-28: IT Discovery Tool Data Source—MSSQL

Process Type » Mashup Source » Data Source

Selact Data Source
Specity data source and location of discovery tool.
& MSSOLC Oracle € DE2 © MySQL € PosigreSOL € Sybase

3

Configuration File: | Use a custorn file =l

custom Fie. | Uptosaconty

Server Name: I

Database: |

T Use Windows Authentication

User Name: |

Password: | | Test Connection |

[

® Server Name—Enter the name of the database server.
® Database—Enter the name of the database.
® Use Windows Authentication—Click the checkbox to enable Windows authentication.

® User Name—Enter the authentication domain/username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 6-29: IT Discovery Tool Data Source—Oracle

Process Type > Mashup Source » Data Source

Select Data Source
Specify data source and location of discavery tool,

© MSSOUE Oracle ¢ DB2 € MySOL ¢ PostgreSGL € Sybase

Configuratian File- | se a custom file - 3
ot | o
Server Name. | port [1521

£ sip: |

© service Name: |

UserName: |

Password: | [ Tost Connection

Lol

® Server Name—Enter the name of the database server.
® Port—Enter the port used to connect to the database.

® SID—Click this radio button to enable use of the System Identifier (SID) that identifies the database instance,
and then enter the system identifier (database name + instance number; e.g. database3).

® Service Name—Click this radio button to enable use of a ‘connector’ to one or more instances of the
database, and then enter the Service Name (e.g., sales. us.example. com).

® User Name—Enter the username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 6-30: IT Discovery Tool Data Source—DB2

Process Type » Mashup Source » Data Source

Select Data Source
Specity data source and logation of discovery tool.

© MSSOLC Oracle [FDB2 © MySOL © PostgreSQL  Sybase

Configuration File: | | jse a custom file ,j
Custom File: | m
Server Name: | port [5000C
Database: |
Useriarne: I

Password: |

® Server Name—Enter the name of the database server.

® Port—Enter the port used to connect to the database.

® Database—Enter the name of the database.

® User Name—Enter the username that enables access to the database.

® Password—Enter the password that enables access to the database.

Modifying Configuration to Extract and Process DB2 Data

This section provides step-by-step instructions for enabling the BDNA Data Platform DB2 extractor to extract data from a
DB2 database using the IBM Native Provider rather then the default MS OLEDB Provider.

The process described here requires modification to the Normalize DatabaseProvider.configfile, located in
<Installpath>\BDNA\Normalize\Conf,using a text editor such as Notepad.

Task To extract data from a DB2 database:
1. OpentheDatabaseProvider.configfilein atexteditor.

2. Bydefault, the standard Normalize 4,3 extractor uses the MS OLEDB Provider for DB2, as shown in
DatabaseProvider.config with DB2 MS OLEDB Provider activated You must edit the DatabaseProvider.config
file so that it uses the IBM Native Provider for DB2 instead.
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40

Note « Both the MS OLEDB and the IBM Native Provider are included in the DatabaseProvider.configfile. Only the MS
OLEDB provider is activated by default.

Figure 6-31: DatabaseProvider.configwith DB2 MS OLEDB Provider activated

<1-- DB2 M5 OLEDE Provider —-3»
<Provider DEType="DE2"
Invariant="5System.Data.0leDb"
ConnectionStringBuilder="BDNA.DAC.BDNAConnectionStringBuilder™>
<ConnectionString®>
: <! [CDATA[Provider=DB2CLEDB;Network Transport Library=TCPIP;Network Add
</ConnectionString>
<NotInstall»
: <Message> i
: <! [CDATA[The Normalize server requires the installation of Microsoft O
</Mezgsage> 3
<URL_X86><![CDATA[http://tus&l.bdna.comeawnlnadCompunent.aspx?CHamE=URLH
i <URL X64><![CDATA[http://tus4l.bdna.com/DownloadComponent.aspx?Ciame=URL
</NotInstall>
</Providers

L
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You can make the modification to DatabaseProvider. config simply by commenting out the DB2 MS OLEDB Provider
section and un-commenting the DB2 IBM Native Provider section as shown in DatabaseProvider.config with DB2 IBM
Native Provider activated.

Figure 6-32: DatabaseProvider.configwith DB2IBM Native Provider activated

T
<!—— DB2 M5 QLEDB Provider
<Provider DEType="DB2"
Invariant="5Svstem.Data.0lelDb"™
ConnectionStringBuilder="BDNA.DAC.BDNAConnectionStringBuilder™>
<ConnectionString>
<! [CDATA[Provider=DEZ0LEDE; Network Transport Library=TICPIP;Network
</ConnectionString>
<NotInstall>
<Mes=age

oy,

<1 [CDATA[The Normalize server reguires the installation of Micro=so
</Mezzage>
<URL _¥86><! [CDATA[http://tus4l.bdna.com/DownloadComponent . aspx ?CHame=
<URL_X64><![CDATA[http:fftus&l.bdna.ccmeDwnlDadCcmpcnent.aspx?CName—
</NotInstall>
</Provider>
T
<!—— DB2 IBM Native Provider ——X»
F] <«Provider DEType="DB2"
Invariant="IBM.Data.DB2"™
Type="IEM.Data.DB2.DBZFactory™
ConnectionStringBuilder="BEDNA.DAC . BDNAConnectionStringBuilder™
= <ConnectionString>
: <1 [CDATA[SERVER=%{HOST} : 5{PORT} ; DATABASE=5% {CATALOG} ; UID=5 {USER} ; PWD=
- </ConnectionStrings>
- <HotInstall>
E ' <Mess=sage>

<! [CDATA[The NHormalize server requires the installation of IBM Dat
- </Messager
<URL X8&><! [CDATA[http://www-01.ibm.con/support/docview.wss?uid=swg21l3

| <URL X64><![CDATA[http:// www-01.ibm.com/support/docview.wss?uid=awg2
- </NotInstall>

- </Provider>

Save the modified DatabasaeProvider.config file.

Restart the Normalize service.

Test the connection to DB2.

a. Ifyousee an error status about a required client at the bottom of the page, proceed to If you are using a
Normalize 4.x customized configuration extractor file, you must convert the file to BDNA Data Platform format.

b. Ifyou are able to connect successfully, the modification process is finished. Proceed to Enter configuration values
for the discovery tool’s data source and location..

If you need to install the IBM Data Server Runtime Client, use the link provided here: http://www-01.ibm.com/support/
docview.wss?uid=swg21385217. Clicking the link opens the IBM Data Server Client Packages page.
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8. OntheIBM Data Server Client Packages page, click the IBM Data Server Runtime Client link.

Figure 6-33: Link to IBM Data Server Runtime Client

Download initial Version 10.5 clients and drivers

News

Abstract
[Bh Data Server Client Packages - Version 10.5 GA

Content

Version 10.5 GA

¢
¢

.

:
¢
-

Package

provides support for Java (JDBC and 5
drvers for open source languages like

called CLPPius that is capable of exec
reparts

and JOBC 4 standard. Also called as JC

Connectraty (ODBC) and Call Level Inte

1B Data Server Driver Package (D3 Drivar] This package contains dimvers and lib,
1 mver for [l £ Prowdes support for JOBC and SQLJ 4
fioe T This is the smallest of all the client pack:
| t Runti i This package is a supersel of Data 5

and hibranes. 1t includes DB2 Comma

D St 0 e s B ad T el op e

Note « You are required to have an IBM ID to download the Data Server Runtime Client.

a. Select the appropriate download for your Normalize installation:

® Select the IBM 32-bit Data Server Runtime Client if you are running Normalize in 32-bit mode

®  Select the IBM 64-bit Data Server Runtime Client if you are running Normalize in 64-bit mode

b. Download and install the IBM Data Server Runtime Client you selected.
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9. You have completed the modifications necessary to extract and process data from your DB2 database. Reboot your
system if necessary, and re-launch Normalize.

Figure 6-34: IT Discovery Tool Data Source—MySQL

Process Type » Mashup Source » Dafa Source

Select Data Source
Specity data source and location of discovery tool.
& MSSQLC Oracle ¢ DE2Z © MyS0L © PostgreSGL © Sybasze

Configuration File: lu:sj‘:_a::!sio[n file

server Name: |

Database: |

T Use Windows Authentication

user Name: |

Password: I — —

® Server Name—Enter the name of the database server.
® Database—Enter the name of the database.

® User Name—Enter the username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 6-35: IT Discovery Tool Data Source—PostgreSQL

Create Process 7O ‘

Process Type » IT Discovery Tool » Data Source

Select Data Source
Specity data source and location of discovery todl.
C MSEALC Oracle DB ¢ MySQL [FPosgreSOL « Sybase

Configuration Fie. | |ize & custom file |

Custom File: |

Server Name: |

Databaze I

Liseriame I

Passward: I

® Custom File—Click Upload Config and select the custom file to be used for this process. (This option may be
grayed-out and not available, depending on the database settings.)

® Server Name—Enter the name of the database server.
® Port—Enter the port used to connect to the database.
® Database—Enter the name of the database.

® User Name—Enter the username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 6-36: IT Discovery Tool Data Source—Sybase

Process Type > Mashup Source > Data Source

Select Data Source
Specify data source and location of discovery tool.

C MSSOLC Oracle ¢ DB2 © MySOL ¢ PostgreSOL [ Sybase

Configuration Flle. | |Jse & custom file 5

Custorn File: |

Server Name: |

Database: |

userName: |

passworg: | | Test Connection |

® Server Name—Enter the name of the database server.

® Port—Enter the port used to connect to the database.

® Database—Enter the name of the database.

® User Name—Enter the username that enables access to the database.

® Password—Enter the password that enables access to the database.

Using HP Universal Discovery (XSF) as a Data Source

Task To configure XSF as a data source:

1. Click Create Process, located in the upper-right section of the Administration Console.
2. Click the IT Discovery Tool radio button.

3. Click Next.
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4.

Select HP Client Automation. The discovery tools are listed in alphabetical order and may require scrolling the window

to see the entire list.

Figure 6-37: IT Discovery Tool—HP Universal Discovery (XSF)

Create Process

P Type » IT D y Tool

Select [T Discovery Tool
Sefect a discovery tool you want to normalize.
© BMC BladelLogic Chent Automation
© BMC BladelLogic Server Automation
CCA [T Client Manager (ITCM)
© CiscoWorks LAN Management Solution (LMS)
« Dall KACE
« HP Clisnt Automation
« HP DD
C HF DDMa
 HF Server Automation
 HF Universal Discovery
BHP Universal Discovery (XSF)
« 1B License Metric Tool
C IBM TCM
 IBM Tivol Application Dependency Discovery
Manager
© IBM Tivoli Assat Discovery for Distributed

© Microsoft Assessment and Planning Toolkit (MAP) 7
© Microsoft Assessment and Planning Toolkit (MAR) &
C Microsoft SMS 2003

 Microsoft System Center Configuration Manager
2007

© Microsolt System Center Configuration Manager
2012

€ Movell ZEMworks

COCs

 Scalable

o Vihiware vCenter Protect

© SenviceMow Discovery

€ Cther. Database Connection

© Other: Mormalize Zip File
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5. Click Next. The Select Data Source screen opens.

Figure 6-38: IT Discovery Tool Data Source—HP Universal Discovery (XSF)

Create Process 7 Q

Process Type » IT Discovery Tool » Data Source

Select Data Source
Specify input folder and actions.

|»

Input Folder

WIF In I

User(domaintusername). [

Password |

Atlions
Rules, @& UpdaleXSF ¢ MoweXSF ¢ Delele XSF © None

Batch Sz | jtiéti_% (-1 = unlimited)

#SF Out |

User{domainusernarme), [

Passworg; |

14l

® [nputFolder:
® XSF In—Enter a path to the folder that contains the XSF files you want to Normalize.
® User (domain/username)—Enter the domain and username that enables access to the “XSF in” folder.
® Password—.Enter the password that enables access to the “XSF in” folder.
® Actions:
® Rules—

® Update XSF: Select “Update XSF” to move the XSF files from the “XSF In” folder to the “XSF Out” folder. The
XSF files in the “XSF Out” folder will contain updated normalized data.

® Move XSF: Select “Move XSF” to move the XSF files from the “XSF In” folder to the “XSF Out” folder.

® Delete XSF: Select “Delete XSF” to remove the XSF files from the “XSF In” folder. No entry fields for an “XSF
Out” folder path or for authentication credentials are available for this option. Once normalized, the XSF files
are deleted.

® None: Select “None” to keep the XSF files in the “XSF In” folder. No entry fields for an “XSF Out” folder path
or for authentication credentials are available for this option. Once normalized, the XSF files remain
available in the “XSF In” folder. If you rerun Normalize, the same XSF files will be re-normalized.

® Batch Size—Specify the maximum number of XSF files to be processed by each normalization.
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6.
7.

® XSF Out—Enter a path to the output folder that will contain the normalized XSF files.

® User (domain/username)—Enter the domain and username that enables access to the “XSF out” folder.

® Password—Enter the password that enables access to the “XSF in” folder.

Click Test Connection to verify the connection.

Complete one of the following options:

® To configure the Process Settings now: Click Next and go to Configuring IT Discovery Tool Process Settings for

detailed instructions.

® To configure the Process Settings later: Click Finish to add the process to the BDNA Normalize Console.

Using ServiceNow as a Data Source

=
Task Configure ServiceNow as a data source:
1. Click Create Process, located in the upper-right section of the Administration Console.
2. Click the IT Discovery Tool radio button.
3. Click Next.
4. Select ServiceNow. The discovery tools are listed in alphabetical order and may require scrolling the window to see
the entire list.
Figure 6-39: IT Discovery Tool—ServiceNow
Create Process 2 9 ‘
Process Type = IT Discovery Tool
Select [T Discovery Tool
Select 3 discovery ool you want to normalize;
« BrC ADDM © Lansweesper =]
© BMC Bladelogic Chent Avtomabon C ManageSoft Enterpnse Compliance Manager (ECM)
~ BMC Bladelogic Server Autormiation © Microsoft Assessment and Planning Toolkit (MAFR) T
CCA IT Chent Manager (ITCM) © Microsoft Assessment and Planning Toolkit (MAR) &
 CiscoVorks LAN Management Solution (LMS) © Microsaoft SMs 2003
« Dell KACE C Microsaoft System Center Configuration Manager
 HP Client Automation 2007
 HP DDMa © Microsoft System Center Configuration Manager
€ HF DDMI 2012
© HP Server Awomation © Movell ZEMworks
" HF Liniversal Discovery C oOCS
1B License Metric Toaol & Scalable
1B TC © Viviware yCenter Protect
B Tiveli Applcation Dependency Discovery [FISerdceMow Discovery
anager © Cther Database Connection
€ Cther. Nomalize Zip Fils =
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Click Next. The Select Data Source screen opens.

Figure 6-40: IT Discovery Tool Data Source—ServiceNow

Create Process

Poocess Type » 1T Discovery Teol > Data Source

Select Data Source

Specity data source and location of discovery toal.

W AR
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Senicehow instance URL |

Usernarme: |

PASSWOIT |

ServiceMNow Work Folder (LNC Path)

Foider Path |

User (domainusername) |

Passward: |

Place a check in the APl checkbox.

Note - If you want to manually trigger a normalization from ServiceNow, you can disable the API calls from the

Normalize server by un-checking the API checkbox.

Provide the ServiceNow Instance URL.

Provide the Username and Password for your ServiceNow Instance.

Provide the ServiceNow work folder location in UNC format (for example, \\server-name\shared-resource-

pathname)

Note - This folder is configured in the ServiceNow update set settings. ServiceNow will extract the data from the CMDB

and copy the data locally on that folder (mid-server).

10. Provide the Username and Password for access to the ServiceNow work folder.

11. Click Test Connection to verify the connection.

12.

BDNA Data Platform 5.5

Complete one of the following options:

® To configure the Process Settings now: Click Next and go to Configuring IT Discovery Tool Process Settings for

detailed instructions.
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® To configure the Process Settings later: Click Finish to add the process to the BDNA Normalize Console.

Using a Normalize Zip File as a Data Source

=
Task Configure a zip file as a data source:
1. Click Create Process, located in the upper-right section of the Administration Console. The Process Type screen opens
2. Click the IT Discovery Tool radio button.
3. Click Next.
4. Select Other: Normalize Zip File. You may need to scroll to the bottom of the list.
5. Click Next. The Select Data Source screen opens.
6. Complete the steps for one of the following options.
® Ifthe Zip fileis on a local server: (see IT Discovery Tool Data Source— Zip File on Local Server)
® C(Clickthe checkbox: Upload local data source.
® Click Upload ZIP and select the file to upload.
e Ifthe Zip file is on a network or BDNA Data Platform server: (see IT Discovery Tool Data Source— Zip File on
Network Server)
® Uncheckthe Upload local data source checkbox.
® Entera local path and authentication for the file located on either a network or Normalize server.
®  Click Test Connection to confirm that BDNA Normalize can connect to the data source.
Note » You must see the status message “Connected Successfully” to activate the Next button and proceed with the
configuration.
7. Complete one of the following options.
® To configure the Process Settings now: Click Next and go to Configuring IT Discovery Tool Process Settings for
detailed instructions.
® To configure the Process Settings later: Click Finish to add the process to the Administration Console.
Figure 6-41: IT Discovery Tool Data Source— Zip File on Local Server
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Create Process 7

Progess Type » IT Discovery Tool » Data Source

Select Data Source
Browse and Upload a local data source. or specity the location of 2 data source on @ network or a Normalize server,

F Upload local data source

Figure 6-42: IT Discovery Tool Data Source— Zip File on Network Server

Create Process 7 @ ‘
Process Type » T Discovery Tool » Data Source
Select Data Source

Browse and upload a local data source, or specity the location of a data source on-a network or a Normalize server.

Tuptoad local data source
If unchecked, you must provide a network path or local path on the normalize server

ZipFile; |

User (domainiusemame). |

Password |

Configuring IT Discovery Tool Process Settings

If you clicked Next after configuring Data Source settings, you can specify History Mode, Metering Rules, and Output
Formats for the discovery process—while configuring the process.
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Setting History Mode for IT Discovery Tool Process

When you are creating a process, use this screen to accept or modify the default inventory name, and set a history mode
and schedule.

® |nventory Name—Accept the pre-populated name or enter a new inventory name.
® History Mode—Click the radio button next to the setting you want to activate.
® Don’t Keep History—Always overwrite the most recent Normalization
® Keep History—Activate history for Analyze and/or Normalize
® In Analyze—Activate Analyze history
® In Normalize—Activate Normalization history
®  Keep the last normalization of each—Place a check next to the schedule you want to activate.
®  Store the last Normalization of each Week
®  Store the last Normalization of each Month
® Store the last Normalization of each Quarter
®  Store the last Normalization of each Year

® Upto: 1-99 Weeks, Months, Quarters, or Years

A

Caution - Selecting “Keep History” saves all inventory data to Analyze and/or Normalize. Depending on the number of
assets, saved inventories can grow very large and severely impact Data Platform application performance, especially

reporting and analysis. BDNA advises caution when setting “Keep History” values, and recommends monitoring saved
inventory sizes frequently.
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Note « Click Next to proceed to the Metering settings screen

Figure 6-43: Setting History Model

Create Process 2 @

Process Type » IT Discovery Teol » Data Source » History

Manage History

Inventory Name: HPUD

History:
(@ Don Keep History
) Keep Histary

Keep the last normalization of each:

O week BA Month [ Quarter [ Year

Upte: | an Year(s)

Setting Metering Rules

Use this screen to view and edit when software is shown as being used. Metering options are dependent on the IT Discovery
Tool. If an IT Discovery tool does not provide metering information, the option will still be visible in the Ul, but will not be
available for use.

® Installed date—Place a check here if you want to calculate the usage based on the installed date.
® Recently run—Place a check here if you want to calculate the usage based on the last run date.

® Using software metering data—Place a check here to specify the rules that define what determines the “use” of
software. Click either radio button to specify the following:

® The application is considered to be used if run over a specified number of minutes in the last specified number of
months.

® The application is used a specified number of times in the last specified number of months.
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Note « Click Next to proceed to the Output Format settings screen.

Figure 6-44: Setting Metering Rules
Create Process ? @

Process Type » IT Discovery Tool » Data Source » Hislory » Metering

Set Metering Rules
The foliowing nules let you specify when software s shown as being used.
Installed date:

Installed | gq Edﬂﬂﬁ] ago.

Recenthy run;
Application has been used within | 30 3: days.
& Using Software Metering data:

® The application is considered to be used, if run over | g, E minutes in the last| 4 E months.

o
O I the application is used | ;4 Eﬂm&s overthepast| 4 3: months.

Setting Output Format

When you are creating a process, use this screen to set the following output formats:
® BDNA Analyze—Check this option to enable output to BDNA Analyze.

® Export results to CSV files—Check this option to enable this type of output format.
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® Directory on Normalize server (Disk space: XX MB)—Shows results file location and available disk space.

Figure 6-45: Setting Output Format

Create Process ? @

Process Type » IT Discovery Tool » Data Source » History » Metering » Output Format

Set Output Format
Wiew data in:
& BDMA User Console

Export results to G35V files

Directory on Nommalize serves (Disk space: 71,7 10MB)

| C:\Program Files\ BDNAData Platform\Results

Note « Click Finish to add the configured process to the Administration Console.

Figure 6-46: IT Discovery Tool (HPUD) Process Added to Administration Console

= HPUD
Con T ez AL Ren T
= weuo » m : : m
| Cné: B Formakraton -
EE Aca Data Source
Vower
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Creating a Purchase Order Process

Normalize for Purchase Orders takes BDNA Normalize beyond the IT sector by aligning and enriching the information
contained in your procurement system. Purchase Order data can be obtained from a database connection, CSV or TXT file,
or Normalize Zip file. The normalized data can be viewed and analyzed in BDNA Analyze or a CSV file.

There are two main steps for creating a Purchase Order process:
® Configuring Purchase Order Data Source Settings
® Configuring Purchase Order Process Settings

Note « Ifyou are using a CSV file, you must configure that file before creating the Purchase Order process. For more
information, see Creating a Purchase Order CSV File

Note « Ifyou are using a database connection or a BDNA Normalize zip file, you must first create an extractor
configuration file.

Configuring Purchase Order Data Source Settings

There are three types of data sources that you can use to create a Purchase Order process: database, CSV or TXT file, or
BDNA Normalize zip file. Instructions for configuring the process with each type of data source can be found at:

® Using a Database Connection as a Data Source
® Usinga CSV File as a Data Source

® Using a BDNA Normalize Zip File as a Data Source
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Using a Database Connection as a Data Source

58

To use a database connection as a data source, do the following tasks:

1.

2.

Click Create Process, located in the upper section of the Administration Console. The Process Type screen opens.
Click the Purchase Order radio button.
Click Next. The Purchase Order Source screen opens.

Figure 7-47: Purchase Order Source

Create Process 7

Process Type » Purchase Order Source
Select a purchase order source
& Other. Database Connection

 Other: File{csy, ba)
o Other Mormalize Zip File

Prev | et |

Click the radio button—Other: Database Connection.

Click the database connection radio button that is applicable to your situation. Options are determined by the
database used by BDNA Normalize.

Select a configuration file (or use a customized configuration file), for the discovery tool you are adding. (For more
information about customizing configuration files, see Creating a Purchase Order Configuration File)

Enter configuration values for the discovery tool’s data source and location.

Note - The specific fields that display on the screen will vary, depending on the database connection previously selected.

Complete one of the following options:

® To configure the Process Settings now: Go to Configuring Purchase Order Process Settings for detailed
instructions.

® To configure Process Settings later: Click Finish to add the process to the Administration Console.
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Figure 7-48: Specifying Purchase Order Data Source Values—MSSQL

Create Process ?

Process Type » Purchase Crder Source » Data Source

Select data source
Specity data source and Iocation of discovery tool.
# MSS0L C Oracle ¢ DBE2 ¢ MySGQL ¢ PostgreS0OL ¢ Sybase

Configuration Fie: || jse a custom file =l

Custom File: |

Server Name. |

Database: |

™ Use Windows Authentication

User Name: |

Password: |

When MSSQL is selected as the data source, the Create Process dialog box includes the following properties:
® Server Name—Enter the name of the database server.
® Database—Enter the name of the database.
® Use Windows Authentication—Click the checkbox to enable Windows authentication.

® User Name—Enter the authentication domain/username that enables access to the database.
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Password—Enter the password that enables access to the database.

Figure 7-49: Specifying Purchase Order Data Source Values—Oracle

Create Process ?

Process Type » Purchase Order Source » Data Source

Select data source
Specity data source and location of discovery tool.

" MSSOLE Omcle ¢ DB2 ¢ MySOL © PostgreS0OL © Sybase

|

Configuration Fite: || jze & custom file ﬂ
custom File: |
Server Name: | Port [1521
* s [

£ Service Name; I

usertiame: |

Passward I

Priv Ned

When Oracle is selected as the data source, the Create Process dialog box includes the following properties:

60

Server Name—Enter the name of the database server.
Port—Enter the port used to connect to f the database.

SID—Click this radio button to enable use of the System Identifier (SID) that identifies the database instance,
and then enter the system identifier (database name + instance number; e.g. database3).

Service Name—Click this radio button to enable use of a ‘connector’ to one or more instances of the
database, and then enter the Service Name (e.g.,sales. us.example. com).

User Name—Enter the username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 7-50: Specifying Purchase Order Data Source Values—DB2

Create Process 7 @

Pracess Type » Purchase Opder Source » Data Source

Select data source
Specity data source and location of discovery tool.
© MSSOL ¢ Oracle [FDE2 ¢ MySQOL ¢ PostgreSOL  © Sybase

Configuration Fite: | ise a custom file =l

Custom File: |

server Name! | Part (50000

Database |

Usertiame: |

Password. | [ TesiGannection |

Prev Mext

When DB2 is selected as the data source, the Create Process dialog box includes the following properties:
® Server Name—Enter the name of the database server.
® Port—Enter the port used to connect to the database.
® Database—Enter the name of the database.

® UserName—Enter the username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 7-51: Specifying Purchase Order Data Source Values—MySQL

Create Process ? @

Procass Type » Purchase Order Source » Data Source

‘Select data source
Specity data source and location of discovery tool,
© MSSOL Oracle ¢ DB2 [MySOL ¢ PostgreSOL  Sybase

canfiguration File || jse 2 custom file ii.

Custom Fie: |

Server Name. | Port (3306

Database; I

UserNarme: I

Fassword; |

When MySQL is selected as the data source, the Create Process dialog box includes the following properties:
® Server Name—Enter the name of the database server.
® Database—Enter the name of the database.

® UserName—Enter the username that enables access to the database.
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Password—Enter the password that enables access to the database.

Figure 7-52: Specifying Purchase Order Data Source Values—PostgreSQL

Create Process ? @

Process Type » Puschase Order Source » Data Source

Select data source
Specity data source and location of discovery tool.

" MSEOLC Oracle ¢ DE2 ¢ MySQL [PostgreSQL  Sybace

Configuration FIlE. | s 3 custom file

Custom File: |

Server Name. |

Database |

Userhame: |

Password: |

When PostgresSQL is selected as the data source, the Create Process dialog box includes the following properties:

Custom File—Click Upload Config and select the custom file to be used for this process. (This option may be
greyed-out and not available, depending on the database settings.)

Server Name—Enter the name of the database server.
Port—Enter the port used to connect to the database.
Database—Enter the name of the database.

User Name—Enter the username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 7-53: Specifying Purchase Order Data Source Values—Sybase

Create Process ? © |

Process Type » Purchase Order Source > Data Source

Select data source
Specify data source and location of discovery taol.
© MSSOLC Qracle © DB2Z ¢ MySQL © PostgreSQL [ Sybase

Configuration File. |1 ce a custom file

Custom File; |

Server Narne; ]

Database: |

Userteamie: |

Password: |

When Sybase is selected as the data source, the Create Process dialog box includes the following properties:
® Server Name—Enter the name of the database server.
® Port—Enter the port used to connect to the database.
® Database—Enter the name of the database.
® UserName—Enter the username that enables access to the database.

® Password—Enter the password that enables access to the database.

Using a CSV File as a Data Source

Note « You must create and customize the CSV, before adding it as a data source for a Purchase Order process. For more
information, see Creating a Purchase Order CSV File.

Task To configure a csv file as a data source:

1. Click Create Process, located in the upper section of the Administration Console. The Process Type screen opens.

2. Click the Purchase Order radio button.
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3. Click Next. The Purchase Order Source screen opens.

Figure 7-54: Purchase Order Source

Create Process 7 @

Process Type » Purchase Order Source
Select a purchase order source
© Qther: Database Connection

[E0ther, Filelcsy, bd)
© Other. Normalize Zip File

4. Click the radio button—Other: File (csv, txt).
5. Click Next. The Purchase Order Data Source screen opens.
6. Complete the steps for one of the following options.
o Ifthe file is on a local server: (see Purchase Order Data Source—ZIP File on Local Server)
® Click the checkbox: Upload local data source.
® Click Upload ZIP and select the file to upload.

o Ifthe file is on a network or Data Platform server: (see Purchase Order Data Source—ZIP File on Network
Server)

® Uncheck the Upload local data source checkbox.
® Entera local path and authentication for the file located on either a network or Normalize server.
®  Click Test Connection to confirm that BDNA Normalize can connect to the data source.

Note « You must see the status message “Connected Successfully” to activate the Next button and proceed with the
configuration.

7. Complete one of the following options:

® To configure the Process Settings now: Go to Configuring Purchase Order Process Settings for detailed
instructions.

® To configure Process Settings later: Click Finish to add the process to the Administration Console.

® Purchase Order Data Source—CSV File on Local Server
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Create Process 2

Process Type » Purchase Order Source » Data Source

Select data source
Browse and upload a local data source, or s:pbcll'ji_th'a Iocation of a data source on anebwork.

EUpload local data source {csv, b)
If the option I1s unchackead, the user should provide a netwiork or server local path.

e msrn

Figure 7-55: Purchase Order Data Source—CSV File on Network Server

Create Process 2 ‘

Process Type » Furchase Order Source » Data Source

Select data source
Brawse and upload a local data source, or specify the location of a data source on a nebwork

Cliupload local deta source (csv, bd)
If the option is unchecked, the user should provide a network or server local path.

Fite: }

User (domainusemame): [

Fassword; [ [T Test Connection ]

Frayv NE
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Using a BDNA Normalize Zip File as a Data Source

Task To configure a zip file as a data source:
1. Click Create Process, located in the upper section of the Administration Console. The Process Type screen opens.
2. Click the Purchase Order radio button.
3. Click Next.
4. Select Other: Normalize Zip File.
5. Click Next. The Select Data Source screen opens.
6. Complete the steps for one of the following options.
o Ifthe Zip file is on a local server: (Purchase Order Data Source—ZIP File on Local Server)
® C(Clickthe checkbox: Upload local data source.
® Click Upload ZIP and select the file to upload.
® Ifthe Zip file is on a network or BDNA Normalize server: (Purchase Order Data Source—ZIP File on Network
Server)
® Uncheckthe Upload local data source checkbox.
® Entera local path and authentication for the file located on either a network or BDNA Normalize server.
®  Click Test Connection to confirm that BDNA Normalize can connect to the data source.
Note » You must see the status message “Connected Successfully” to activate the Next button and proceed with the
configuration.
7. Complete one of the following options.

BDNA Data Platform 5.5

® To configure the Process Settings now: Go to Configuring Purchase Order Process Settings for detailed
instructions.
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® To configure Process Settings later: Click Finish to add the process to the Administration Console.
Figure 7-56: Purchase Order Data Source—ZIP File on Local Server

Create Process 7 D ‘

Frocess Type » Puichase Order Source » Data Source

Select data source
Browse and upload a local data source, or specify the location of @ data source on 3 network or a Normalize server,

F Upload local data source

Zip Fite: |

Figure 7-57: Purchase Order Data Source—ZIP File on Network Server

Create Process 7 @

Frocess Type » Puerchase Order Sgurce » Data Source

Select data source
Browse and upload 3 10cal data source, ar Specify the Iocation of a data sourte on a network or 3 Normalize server,

CluUpload local data source
IF unchecked, you must provide a network path or local path on the normalize server

Zip Fite: |

wser (gomaimusername). [

Password:

Configuring Purchase Order Process Settings

If you clicked Next after configuring Data Source settings, you can specify History Mode, Metering Rules, and Output
Formats for the discovery process—while configuring the process.
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Note « Ifyou clicked Finish while configuring the Data Source settings, you will need to go to ‘Managing Sessions’ to edit the
process settings.

Task Setting History Mode for a Purchase Order Process
When you are creating a process, use this screen to accept or modify the default inventory name, and set a history mode.
1. Click Next. The History screen opens.

Figure 7-58: Manage History

Create Process ? @ |

Process Type 3 Purchase Order Source » Dats Source 3 History

Manage History

Irventory Name: kD\I'H"_1 31121093808

History:
= Dont Keap History
1 Keap History

Finish

2. Click one of the following radio buttons.
® Don’t Keep History

® Keep History

A

Caution - Selecting “Keep History” saves all inventory data to Analyze and/or Normalize. Depending on the number of
assets, saved inventories can grow very large and severely impact Data Platform application performance, especially
reporting and analysis. BDNA advises caution when setting “Keep History” values, and recommends monitoring saved
inventory sizes frequently.
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3. Click Next. The Output Format screen opens.

Figure 7-59: Output Formats

Create Process 7 Q |

Process Type » Purchase Order Source » Data Seurce » History » Oulput Forman

Set Qutput Format
View data inc

™ BOMA Analyze

M Export results to CSV files

Dhrectory on Nomahize seever (Disk space: 19 120ME)

IC\Program FilesiIEDMAWMormalize'\Results

Prey Finish

4. Click one or more of the following checkboxes.
® BDNA Analyze
®  Export results to CSV files
5. Click Finish. The Purchase Order process is added to the Administration Console.

Figure 7-60: Purchase Order Process added to Administration Console

2= COW_131121093808 B Ovens  # Sesngs

AT SO I | wosniaioon af dn 14

B con_ sz -H | e | L=

Qe Lemep: Noemoadzation

EE o0 Dots Source

ACTHATY

Creating a Purchase Order CSV File

Data that you import from an external data source must be converted to a CSV file format before it can be loaded into BDNA
Normalize.

Note - To load data directly from a database connection, see Using a Database Connection as a Data Source
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CSV Header

The CSV columns header is used to define which columns will be using for mapping and which will only be used as
additional information. Set the mapping field definition in the CSV Header.

® Foradetailed list of objects, mapping fields, and limitations, see ‘Objects and Mapping Fields’.

® Foranexample of a Purchase Order CSV file, see Sample Purchase Order CSVObject: Purchase OrderMapping Fields:

Matching Key Column

Each column used as a mapping field must have a header written in the following format:
KEY - XXXXXXX: YYYYYYY

Where XXXXXXX is:

® The mapping field name. (See KEY_ITEM.KEY definition in ‘Objects and Mapping Fields’.
Where YYYYYYY is:

® The original label of the column

Other Columns

All other header columns must be labeled as standard CSV columns. If you are also using BDNA Analyze, the labels will be
used as Dimension attribute names.

Note « You cannot have two columns with the same label.

Table 7-1 « Sample Purchase Order CSVObject: Purchase OrderMapping Fields:

Customer  KEY- KEY- KEY- KEY- KEY- KEY-
Order Ref START_DATE: PRODUCT_DES MANUFACTURER: MFR_PART_NO: QUANTITY: QUANTITY:
(zXe)] Date of C: MFG Name MFG Part (0147 (0147

Invoice Item Number
Description

17996 1/25/2005 IBM 3YR IBM Options Service | 58P8774 1 $262.00
9X5XNBD Agree
ONSITE+ADP
SVC LAPT
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Customer
Order Ref
(3Xe)]

KEY-

START_DATE:

Date of
Invoice

KEY-
PRODUCT_DES
(&

Item
Description

KEY-

MANUFACTURER:

MFG Name

KEY-

MFG Part
Number

MFR_PART_NO:

KEY-
QUANTITY:
Qty

KEY-
QUANTITY:
Qty

18005CCR | 1/25/2005 IBM 3YR IBM Options Service | 58P8774 1 $262.00
9X5XNBD Agree
ONSITE+ADP
SVC LAPT

18018 1/5/2005 HP PROLIANT HP Server & 346921-001 1 $14,559.00
DL560R 2X 7/3.0 | Accessories
1GB

18018 1/5/2005 EMULEX EMC Emulex Corporation | LP9802-E 2 $1,051.00
2GB 133MHZ FC
HBA PCI

18018 1/5/2005 EMULEX EMC Emulex Corporation | LP9802-E 2 $1,051.00
2GB 133MHZ FC
HBA PClI

18018 1/5/2005 HP 72GB PLUG HP Server & 286778-B22 2 $535.00
U320 SCSI 15K Accessories
HD

18018 1/5/2005 HP 72GB PLUG HP Server & 286778-B22 2 $535.00
U320 SCSI 15K Accessories
HD

18018 1/5/2005 HP 4GB PC2100 HP Memory 300682-B21 4 $2,742.00
DDRKIT Products

18018 1/19/2005 HP DL560 7/3.0 HP Server & 346990-B21 2 $5,800.00
PROC UPG Accessories

123004MM | 1/14/2005 IBM 3YR IBM Options Service | 58P8774 1 $262.00

02 9X5XNBD Agree
ONSITE+ ADP
SVC LAPT

18032CR 1/4/2005 NEC MULTI NEC Display LCD1860NX-BK- | 2 $442.00
LCD1860NX 1
18IN LCD DVI
BLK
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Customer
Order Ref
(3Xe)]

KEY-
START_DATE:
Date of
Invoice

KEY-
PRODUCT_DES
(&

Item
Description

KEY-

MANUFACTURER:

MFG Name
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KEY-
MFR_PART_NO:
MFG Part
Number

KEY-
QUANTITY:
Qty

KEY-
QUANTITY:
Qty

18032CR 1/4/2005 NEC MULTI NEC Display LCD1860NX-BK- |2 $442.00
LCD1860NX 1
18IN LCD DVI
BLK

18035CR 1/4/2005 RSP CPB- HP Server & CPB-333713- 1 $894.00
ML370/DL380 7/ | Accessories B21
3.06 PROC UPG

18035CR 1/4/2005 HP 1GB PC2100 HP Memory 300679-B21 1 $479.00
DDRKIT Products

18037CR 1/4/2005 BROTHER Brother PPF-2800 1 $195.00
INTELLIFAX- International
2800 PLAIN
PAPER

18033CCR | 1/5/2005 HP PROLIANT HP Server & 333704-001 1 $2,958.00
DL380RG3 7/ Accessories
3.06 1GB

18033CCR | 1/5/2005 RSP CPB-PL HP Server & CPB-313054-001 |1 $220.00
DL380 G3 Accessories
REDUN PWR
SUPPLY

18033CCR | 1/5/2005 HP BATTERY HP Computers 255514-B21 1 $198.00
BACKED WRITE
CACHE ENAB

18033CCR | 1/5/2005 HP DL380 G3 G4 | HP Server & 293048-B21 1 $202.00
REDUNDANT Accessories
FAN KIT

18033CCR | 1/6/2005 HP 36GB PLUG HP Server & 286776-B22 2 $305.00
U320 SCSI 15K Accessories
HD

18033CCR | 1/6/2005 HP 36GB PLUG HP Server & 286776-B22 2 $305.00
U320 SCSI 15K Accessories
HD
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Customer
Order Ref
(3Xe)]

18034

KEY-

START_DATE:

Date of
Invoice

1/6/2005

KEY-
PRODUCT_DES
(&

Item
Description

VER STOR
FOUND WIN 4.1
MEDIA

KEY-

MANUFACTURER:

MFG Name

Veritas Software
Licensing

KEY-

MFR_PART_NO:

MFG Part
Number

N121068

KEY-

QUANTITY:

Qty

KEY-
QUANTITY:
Qty

$32.55

18029

1/7/2005

PLANAR PL1700

Planar

997-2795-00

$256.00

17"

KEY-START_DATE:Date of Invoice
Where “START_DATE” is:

® The mapping field name.
Where “Date of Invoice” is:
® The label of this field.

Note « The “START_DATE” field is used for metadata, not for direct mapping.

KEY-PRODUCT_DESC:Item Description
Where “PRODUCT_DESC” is:

® The mapping field name.

Where “Item Description” is:

® The label of this field.
KEY-MANUFACTURER:MFG name
Where “MANUFACTURER?” is:

® The mapping field name.

Where “MFG name” is:

® The label of this field.
KEY-MFR_PART_NO:MFG Part Number
Where “MFR_PART_NO” is:

® The mapping field name.

Where “MFG Part Number” is:

® The label of this field.

KEY-QUANTITY:Qty
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Where “QUANTITY” is:

® The mapping field name.
Where “Qty” is:

® The label of this field.

Note « The “QUANTITY” field is used for metadata, not for direct mapping.

KEY-UNIT_PRICE:Unit Price
Where “UNIT_PRICE” is:

® The mapping field name.
Where “Unit Price” is:
® The label of this field.

Note » The “UNIT_PRICE” field is used for metadata, not for direct mapping.

Other Columns:
The following field is used as an additional attribute under the PurchaseOrder Objects.

® Customer Order Ref (P.O.)

Note « In BDNA Analyze, this field is available as an Attribute under the “Purchase Order” dimension.

Creating a Purchase Order Configuration File

Detailed information about the a Purchase Order configuration file’s headers and fields can be found in ‘Dissecting a
Configuration file’. However, below is an example of a Purchase Order configuration file.

Example: Purchase Order Configuration File

<?xml version="1.0" encoding="utf-8" ?>
<configuration LoaderConfig="po_loader config 20130812" Disc_Source="CDW">
<Connection Type="MSSQLSERVER">
<Property Name="Data Source" Value=""/>
<Property Name="Initial Catalog" Value=""/>
<Property Name="Persist Security Info" Value="True"/>
<Property Name="User ID" Value=""/>
<Property Name="Password" Value=""/>
<Property Name="Integrated Security" Value="false"/>
</Connection>
<Tables>
<Table Type="PurchaseOrder" Name="PO" Dynamic_subtype="PurchaseOrder" Label="CDW"
HiddenFields="">
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<Fields>
<Field

Comment=
<Field

Name="Customer_Order_1" DataType="NVARCHAR(255)" Nullable="1" DefaultValue=""

Key Position="0" FileColumnName="Customer Order Ref (P 0)" Expression="inherit" />

Name="Contact_Name" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""

Key_Position="0" FileColumnName="Contact Name" Expression="inherit" />

<Field Name="Original Date_o3" DataType="NVARCHAR(255)" Nullable="1" DefaultValue=""
Comment="" Key_Position="0" FileColumnName="Original Date of Order" Expression="inherit" />

<Field Name="Order_Number" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key Position="0" FileColumnName="Order Number" Expression="inherit" />

<Field Name="START_DATE" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key Position="1" FileColumnName="KEY-START DATE:Date of Invoice" Expression="inherit" />

<Field Name="Invoice_Number" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key_Position="0" FileColumnName="Invoice Number" Expression="inherit" />

<Field Name="Item_class" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key_Position="0" FileColumnName="Item class" Expression="inherit" />

<Field Name="Product_Class_D8" DataType="NVARCHAR(255)" Nullable="1" DefaultValue=""
Comment="" Key_Position="0" FileColumnName="Product Class Description" Expression="inherit" />

<Field Name="Item_Type" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key_Position="0" FileColumnName="Item Type" Expression="inherit" />

<Field Name="Product_Type_Del@" DataType="NVARCHAR(255)" Nullable="1" DefaultValue=""
Comment="" Key Position="0" FileColumnName="Product Type Description" Expression="inherit" />

<Field Name="Item_Number" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key Position="0" FileColumnName="Item Number" Expression="inherit" />

<Field Name="PRODUCT_DESC" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key Position="1" FileColumnName="KEY-PRODUCT_DESC:Item Description" Expression="inherit" />

<Field Name="MFG_Code" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key_Position="0" FileColumnName="MFG Code" Expression="inherit" />

<Field Name="MANUFACTURER" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key Position="1" FileColumnName="KEY-MANUFACTURER:MFG Name" Expression="inherit" />

<Field Name="MFR_PART_NO" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key_Position="1" FileColumnName="KEY-MFR_PART_NO:MFG Part Number" Expression="inherit" />

<Field Name="Users" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key Position="0" FileColumnName="Users" Expression="inherit" />

<Field Name="Delivery Type" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key Position="0" FileColumnName="Delivery Type" Expression="inherit" />

<Field Name="Reference_Line_18" DataType="NVARCHAR(255)" Nullable="1" DefaultValue=""
Comment="" Key_ Position="0" FileColumnName="Reference Line Number" Expression="inherit" />

<Field Name="QUANTITY" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key_Position="1" FileColumnName="KEY-QUANTITY:Qty" Expression="inherit" />

<Field Name="UNIT_PRICE" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key Position="1" FileColumnName="KEY-UNIT_PRICE:Unit Price" Expression="inherit" />

<Field Name="TOTAL_PRICE" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key_Position="1" FileColumnName="KEY-TOTAL_PRICE:Total Amount" Expression="inherit" />

<Field Name="Serial_Number" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key Position="0" FileColumnName="Serial Number" Expression="inherit" />

<Field
Key Position="0"

Name="Ship_To_Name" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
FileColumnName="Ship To Name" Expression="inherit" />

<Field Name="Ship_To_Address" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""

Key_Position="0"
<Field

Comment=""
<Field

Key_Position="0"
<Field

Comment=""

FileColumnName="Ship To Address" Expression="inherit" />
Name="Ship_To_Attention" DataType="NVARCHAR(255)" Nullable="1" DefaultValue=""

Key_Position="0" FileColumnName="Ship To Attention" Expression="inherit" />

Name="Ship_To_City" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
FileColumnName="Ship To City" Expression="inherit" />
Name="Ship_to_State_Code" DataType="NVARCHAR(255)" Nullable="1" DefaultValue=""

Key Position="0" FileColumnName="Ship to State Code" Expression="inherit" />
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<Field Name="Ship To Zip_ Code" DataType="NVARCHAR(255)" Nullable="1" DefaultValue=""

Key Position="0" FileColumnName="Ship To Zip Code" Expression="inherit" />
</Fields>
<SQL>

<1 [CDATA[

1>
</SQL>

SELECT

[Customer Order Ref (P 0)],

[Contact Name],

[Original Date of Order],

[Order Number],

[Date of Invoice] as 'KEY-START_DATE:Date of Invoice',
[Invoice Number],

[Item class],

[Product Class Description],

[Item Type],

[Product Type Description],

[Item Number],

[Item Description] as 'KEY-PRODUCT_DESC:Item Description’,
[MFG Code],

[MFG Name] as 'KEY-MANUFACTURER:MFG Name',

[MFG Part Number] as 'KEY-MFR_PART_NO:MFG Part Number',
[Users],

[Delivery Type],

[Reference Line Number],

[Qty] as 'KEY-QUANTITY:Qty',

[Unit Price] as 'KEY-UNIT_PRICE:Unit Price’,

[Total Amount] as 'KEY-TOTAL_PRICE:Total Amount',
[Serial Number],

[Ship To Name],

[Ship To Address],

[Ship To Attention],

[Ship To City],

[Ship to State Code],

[Ship To Zip Code]

FROM CDW_DB

<SP><![CDATA[]]></SP>

</Table>
</Tables>

</configuration>
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Managing Processes and Data Sources

You can manage the following processes and data sources from the BDNA Normalize panel of the Administration Console:
® Addingan IT Discovery or Purchase Order Data Source to a Process

® Adding a Data Mashup to a Process

®  Setting Deduping Rules

® Deleting a Data Source from a Process

® Deleting a Process

Adding an IT Discovery or Purchase Order Data
Source to a Process

You can add a data source to an existing process, within the following constraints:
® AnIT Discovery Tool can only be added to an IT Discovery Tool or a Normalize CM process.

® APurchase Order data source can only be added to a Purchase Order process.

Task To add a data source to a process:
1. Click the Add Data Source link, within the process’s Data Source pane. The Create Process screen opens.
2. Click the radio button for the data source type that you want to add.
3. Provide the Data Source information for the data source, using the following instructions:
® [faddingan IT Discovery data source:
® Using ServiceNow as a Data Source, steps 1 - 9.

® Using ServiceNow as a Data Source, steps 9 - 11.
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® Adding a Data Mashup Using a Normalize Zip File steps 1-6.
e |fadding a Purchase Order data source:

® Using a Database Connection as a Data Source, steps 1 - 8.

® Usinga CSVFile as a Data Source steps 1 - 6.

® Using a BDNA Normalize Zip File as a Data Source, steps 1 - 6.

4. Click Finish. The data source is now added to the specified process.

Adding a Data Mashup to a Process

80

A data mashup allows the import of an external data source to the Normalize database. Add a data mashup when you want
to input data from any data sources that are accessible from your BDNA Normalize server. For example, you can input
warranty data from an Accounting database or Human Resource data from a Human Resources database. A data mashup is
added as a separate data source to an existing process.

The following items are prerequisites to creating a data mashup:

®  Your activation key must grant access to the Data Mashup feature

® (Create at least one IT Discovery Tool, Fingerprint, and/or Normalize CM process

® Determine your data source

® (Create a mashup configuration file with instructions for retrieving data from the specified data source

Note » Adata mashup can only be added to an existing IT Discovery Tool or Normalize CM process.

There are three types of data sources you can use as a mashup source:

® Database Connection—Obtainsdata from your MSSQL, Oracle, DB2, MySQL, PostgreSQL, or Sybase database. For
more information, see Adding a Data Mashup Using a Database Connection

®  File (csv, txt)—Obtains data from a CSV or TXT file located on a network or local server. For more information, see
Adding a Data Mashup Using a CSV File
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Zip File—Obtains data from a BDNA Normalize zip file located on a network or local server. For more information, see

Adding a Data Mashup Using a Normalize Zip File

Figure 8-61: Example of a Data Mashup Using CSV Files

Warranty Data.csv HR.csv
Machine | Asset Tag | Warranty Date Username | Org level 1| Org level 2 Location
ACME123 ¥DLADZ 12/21/2008 bdnacorpitlipn | Comorate T ML View, CA
ACME258 YDOALADZ 11/6/2001 bdnacorpircha Comorate Prof. Swcs. Tampa, FL

HOST_ID | HOSTHNAME | SERIALNUMBER USERNAME
1 ACME123 ANQSEE3 benacorpiblipp
2 ACMEZ256 BKSPAS4T bdnacom'rcha
J
HOST_ID| PUBLISHER SOFTWARENAME VERSION | EDITION

1 Microsoft Office 2013 Professional

1 ViMWare Waorkstation {VMWare Workstation) 5

1 RealVNG VNG (Virtual Network Computing) 4

1 Microsoft SOL Saner 2008

2 Mctfas VirusScan Enterprise T

2 Sap Crystal Reports for Visual Studio [NET 2008

2 Adobe Systams Creative Suite C53 Master Collection

2 Micrasoft Virtual Sarvar 2003

2 Citrix Systems KenApp 1

Nomalize Data
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Adding a Data Mashup Using a Database Connection

82

Adding a data mashup:

1. Click Add Data Source, located on the BDNA Normalize panel of the Administration Console. The Select Data Source

Type screen opens.

Figure 8-62: Add Data Source Type

Data Source Type
Select Data Source Type

o ! IT Discovery Tool
Confighigr, Attiris, DDMI, 81¢...

¢ == Purchase Order
== cDW,Insignt, SHI, etc,

& = Data Mashup
Import amy external data source (Excel, elc.) to Normalize database,

(-] E Mormalize Ch
Populate Confighgr database with normalized data,

] ’ Fingerpnnts
Extend capabilities of existing discovery tool,

2. Click the Data Mashup radio button.

3. Click Next. The Mashup Source screen opens.
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4. Click the Other: Database Connection radio button.

Figure 8-63: Mashup Source

Process Type 3 Mashup Ssurce

Sedpct o Mashup Source
Select 30UNTE type,

& Other. Database Conmechon
r Other, File{csv, bd)
© Ogher: Nomakzoe Jp Fils

Frey hea

5. Click Next. The Select Data Source dialog opens.

6. Click the database connection radio button that is applicable to your situation. Options are determined by the IT
Discovery Tool process and type of database used by BDNA Normalize.

7. Select a configuration file (or use a customized configuration file), for the discovery tool you are adding. (For detailed
information about the values required in the customizable sections of a configuration file, see (Appendix C
Configuration File Dissection)

8. Enter configuration values for the discovery tool’s data source and location.

Note - The specific fields that display on the screen will vary, depending on the database connection previously selected.
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9. Click Finish to add the data source to the process.

Figure 8-64: IT Discovery Tool Data Source—MSSQL

Process Type » Mashup Source » Data Source

Selact Data Source
Specity data source and location of discovery tool.

& MSSALC Oracle © DE2 © MySOL © PostgreSAL ¢ Sybase

Configuration Filg: lUs—_e._a_,:Es_:m:n file -

B
Custom File: | _

Server Name: |

Database: |

[ Use Windows Authentication

User hame; I

Password: I —

(N

When MSSQL is selected as the data source, the Create Process dialog box includes the following properties:
® Server Name—Enter the name of the database server.
® Database—Enter the name of the database.
® Use Windows Authentication—Click the checkbox to enable Windows authentication.

® User Name—Enter the authentication domain/username that enables access to the database.
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Password—Enter the password that enables access to the database.

Figure 8-65: IT Discovery Tool Data Source—Oracle

Process Type » Mashup Source » Data Source

Select Data Source
Specity data source and location of discovery tool.

C MSSOUE 0racle © DB2 © MySOL ¢ PostgreSQL  C Sybase

Confguraton Fle: [Useacustonfe 5]
Custom File: | . Upload Confiy
Server Name: | Port [1521

® sip; |

C senvice Name: |

UserName: |

Password: | | Tost Connection

K|

When Oracle is selected as the data source, the Create Process dialog box includes the following properties:

Server Name—Enter the name of the database server.
Port—Enter the port used to connect to the database.

SID—Click this radio button to enable use of the System Identifier (SID) that identifies the database instance,
and then enter system identifier (database name + instance number; e.g. database3).

Service Name—Click this radio button to enable use of a ‘connector’ to one or more instances of the
database, and then enter the Service Name (e.g.,sales. us.example. com).

User Name—Enter the username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 8-66: IT Discovery Tool Data Source—DB2

Process Type » Mashup Sowrce » Data Source

Select Data Source
Specity data source and location of discovery tool.
€ MSSOLC Oracle (FDB2 € MySOL © PostgreSOL © Sybase

Configuration File: | | ige a custom file =l

S—— sscery

Server Name. | Port [S000C

Database |

Lrseriarme I

Passwora |

Prev Finish

When DB2 is selected as the data source, the Create Process dialog box includes the following properties:
® Server Name—Enter the name of the database server.
® Port—Enter the port used to connect to the database.
® Database—Enter the name of the database.

® User Name—Enter the username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 8-67: IT Discovery Tool Data Source—MySQL

Process Type > Mashup Source > Data Source

Select Data Source
Specity data source and location of discovery toal.

C MSSQLC Oracle ¢ DB2 [FMySOL © PosigreSQL ¢ Sybase

Configuration File: [ Jse a custom file |

Custom File: | _

Server Name: | Port [3306

Database: |

Password: |

Pray

When MSSQL is selected as the data source, the Create Process dialog box includes the following properties:
® Server Name—Enter the name of the database server.
® Database—Enter the name of the database.

® User Name—Enter the username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 8-68: IT Discovery Tool Data Source—PostgreSQL

Process Type » Mashup Source » Data Source

Select Data Source
Specify data source and location of discovery tool.
© MSSQLC Omacle ¢ DE2 ¢ MySQL [ Postgre30L ¢ Sybase

Configuration File: | {Jse 2 custor file =l
Custom File: | | Upload Conflg
Server Name: | port [5432
Database: |
useriame: |

Password: | | Test Connection |

When PostgreSQL is selected as the data source, the Create Process dialog box includes the following properties:

® Custom File—Click Upload Config and select the custom file to be used for this process. (This option may be
greyed-out and not available, depending on the database settings.)

® Server Name—Enter the name of the database server.
®  Port—Enter the port used to connect to the database.
® Database—Enter the name of the database.

® User Name—Enter the username that enables access to the database.
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® Password—Enter the password that enables access to the database.

Figure 8-69: IT Discovery Tool Data Source—Sybase

Process Type » Mashup Source » Data Source

Select Data Source
Specity data source and location of discovery taol.
© MSSQLC Oracle ¢ DE2 ¢ MySOL © PostgreSOL [ Sybase

Configuration Fite: [ se a custom file =l

Custorn File: |

Server Name: | Port: 5000

Database: |

UserName: |

Password: |

When Sybase is selected as the data source, the Create Process dialog box includes the following properties:
® Server Name—Enter the name of the database server.
® Port—Enter the port used to connect to the database.
® Database—Enter the name of the database.
® User Name—Enter the username that enables access to the database.

® Password—Enter the password that enables access to the database.

Adding a Data Mashup Using a CSV File

There are two primary steps for adding a data mashup using a CSV file:
® (Creating a Mashup CSV File

® Adding a CSV File as a Data Mashup Source

Creating a Mashup CSV File

Data that you import from an external data source must be converted to a CSV file format before it can be loaded into BDNA

Normalize.
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Note « To load data directly from a database connection, see Adding a Data Mashup Using a Database Connection

CSV Header

The CSV columns header is used to define which columns will be used for mapping and which will only be used as
additional information. Set the mapping field definition in the CSV Header.

® Foradetailed list of objects, mapping fields, and limitations, see “Objects and Mapping Fields.”

® Foranexample of a Data Mashup CSV file, see Example of a Data Mashup Using CSV Files.

Matching Key Column

Each column used as a mapping field must have a header written in the following format:
KEY = XXXXXXX: YYYYYYY

Where XXXXXXX is:

® The mapping field name. (See KEY_ITEM.KEY definition in Objects and Mapping Fields)
Where YYYYYYY is:

® The original label of the column

Other Columns

All other header columns must be labeled as standard CSV columns. If you are also using BDNA Normalize, the labels will be
used for BDNA Normalize attribute names.

Note « You cannot have two columns with the same label.

CSV File Examples

The following Mashup CSV file provides examples of Objects and Mapping Fields. Object: User!

Table 8-2 .
KEY-DomNain\Uername:FullUserName DEPT1 DEPT2 SITE1 LOC
ACME\jsmith Corporat | Marketing | US NY
e

[

1.For a Mashup CSV file, you must use the Normalize Ul to define the main object to which the data is to be attached.
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Table 8-2.
KEY-DomNain\Uername:FullUserName LOC
ACME\adunn Corporat | Marketing | ASIA SG
e
ACME\lthor Corporat | Marketing | US WA
e
ACME\sadams Corporat | Marketing | US X
e
Mapping Fields

KEY-Domain\Username:FullUserName

Where Domain\Username is:
® The matching key name
Where FullUserName is:

® The label of this key

Other Columns

The following fields are used as additional attributes under the User object:

® DEPT1
® DEPT2
e SITEL
e |0C

Note - In BDNA Normalize, the fields shown above are available as Attributes under the “User” dimension.

Adding a CSV File as a Data Mashup Source

Task To add a csv file:
1. Click Add Data Source, located on the Console. The Select Process Type screen opens.

2. Click the Data Mashup radio button.
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3. Click Next. The Mashup Source screen opens.

Figure 8-70: Mashup Source

Process Type » Mashup Source
Sedoct 8 Mashup Sourcn
Select source type.

& Other. Database Connection
o Ogher: Filp(csy, bd)
€ Other: Normalze 2p Fike

4. Click the Other: File (csv, txt) radio button.
5. Click Next. The Data Source screen opens.

Figure 8-71: Data Source

Process Type 3 Mashup Source » Data Source

Select Data Source

Browse and upload a local data source, or specify the location of a data source on a network or a Normalize server.

Select an object to link the data to: |Machine =

¥ Upload local data source

File: |
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Select an object from the drop-down list. When you select an object, the data imported from the CSV file will be attached
to the object.

Note « The CSV file should have a mapping key allowed by the selected object. Reference tables for all available Objects

and Mapping Fields that can be used for Data Mashup, Pass-Through, and Purchase Order, can be found in Reference
tables for Objects and Mapping Fields

The objects, which are the data that the mashup process links to, are:
® Machine

® User

® Software

® Hardware

® OS

e CPU

®  Manufacturer

®  Other (imported data is not attached to any object)
Click the Upload local data source checkbox.

Click Upload CSV to locate and upload the data mashup file.

Click Finish.

Data Mashup Using a Normalize Zip File

Task To add a data mashup:

1.

2.

BDNA Data Platform 5.5

Click Add Data Source, located on the main screen of the Normalize Console. The Select Process Type screen opens.

Click the Data Mashup radio button.
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3. Click Next. The Mashup Source screen opens.

Figure 8-72: Mashup Source

Process Type » BMashup Seurce

Sedoct a Mashup Source
Select source type,

@& Other. Database Conneclion
 Other. File{csy, bd)
« Other: Normakae Zip Fike

Piress | Mea

4. Click the Other: Normalize ZIP File radio button.
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5. Click Next. The Data Source screen opens.

Figure 8-73: Data Source

Diata Source Type » Mashup Source » Data Source

Select Data Source
Browse and upload 2 local data source, or specify the lacation of 3 data source on 2 network or a Normalize server,

F Upload local data source

Zip File: | _

6. Make sure that the Upload local data source checkbox is checked.
7. Click Upload Zip.
8. Select the Zip file that you want to use.

9. Click Finish.

Setting Deduping Rules

When you add multiple data sources to an IT Discovery Tool process, there is a possibility that normalization will gather
duplicate entries for the raw data. You can specify deduping rules to eliminate duplication of data.

Note « Deduping rules do not apply to data mashup data sources. Normalize CM is no longer available.
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Task To specify deduping rules:

1. Click the Details link (Process Details). The Data Source pane expands to include priority information about each data
source.

Figure 8-74: Process Details

== Normalize CM

DATA SOURCE

= i
== MNormalize Chi &

Prioirty: 1 B |

Source: MS30L_wm-
sccm01.scem2012a.com

[ |
a Ch 2012 &
Prioirty: 2 F|
Source: MESAL_vm-scem0l |
|
- Data Mashup1 &>
Prioirty: 3

Source: CiProgram Filesy .
V0002 _machine csy

Add Data Source

== DEDUFING RULES

2. Click the Deduping Rules link, located at the bottom of the expanded Data Source details pane, beneath the Add Data
Source link. The Deduping Rules dialog opens (Deduping Rules).

3. Click the checkbox: Activate deduping functionality.
4. Select a deduping key from the Deduping key drop-down. The available deduping rules are:
® Hostname (domain\machine)
® Domain + Hostname
® Hostname + Serial Number
® Hostname
® Serial Number

® Serial Number only (except Virtual Machines), and for machines without a Serial Number.
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5. Usethe down and up arrows to set the order in which deduping will occur.

Figure 8-75: Deduping Rules

Deduping Rules N %

Activate deduping, set key, and prioritize.

M g ctivate deduping functionality

Deduping key:  |Hostname {damainimachine) =]

Prority list: ChA 2012 —

Deleting a Data Source from a Process

Note - If a process has multiple data sources, the first data source that was created can only be deleted after the other data
sources are deleted.

Task To delete a data source from a process:

1. Click the Settings link located on the right-side of the process overview pane. The Settings screen opens.

2. Click Delete Data Source. A Confirmation dialog opens.
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3. Click OKto confirm that you want to delete the data source.

Figure 8-76: Delete Data Source

General

Dala Mashup
Import arry external data source (Excel, LDAP, etc) to Mormalize database

Data Source Name:  [em_001

Mashup Source: [ Other. Database Connection =l

Deleting a Process

Note » Deleting a process does not delete Inventory data.

Task To delete a process:
1. Click the Settings link located on the right-side of the process overview pane. The Settings screen opens.
2. Click Delete Process. A Confirmation dialog opens.
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3. Click OK to confirm that you want to delete the process.

Figure 8-77: Delete Process

Inventary Name:  [COW_1211210933808

Histony:
& DonlKeep History
 Keep History
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Running Normalize

The Process panel of the Administration Console shows the time of the last BDNA Normalize operation. It also lets you run
BDNA Normalize on either an on-demand or scheduled basis.

Choose from the following options to run Normalize:
®  Running BDNA Normalize On Demand

® Setting Up a Simple BDNA Normalize Schedule
®  Setting Up a Weekly Normalize Schedule

® Stoppinga Normalization Operation in Progress

Running BDNA Normalize On Demand

Click Start Process on the Administration Console to begin a BDNA Normalize process on demand. During processing, a
processing status is displayed in the panel below and to the left of the Start Process button.

Figure 9-78: Normalize On-Demand Showing Activity Status

2= CM 2012 B Cetes o Seteqs
B cusnz » |_< ! ™ .

| L Mt Seaoubed = = =
= wm_oo » | I e s, $RATHE TR

-

L r
EE acaData Source
ACTRTY ) 0N 2012 TASK IO  [16751] IMPORTING TABLE MAME F95_MBTIML_ WA HINE] CAMCEL
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Setting Up a Simple BDNA Normalize Schedule

Task Use a simple schedule to launch BDNA Normalize at recurring intervals that correspond to hours, days, weeks, or
months.

1. Click the Details icon to open the Schedule panel.
2. Select the Simple Schedule radio button.

Figure 9-79: Simple Schedule

Start Process

L Mot Scheduled

" Do Mat Schedule

@ Simple Schedule

Recur every B0 I Day(s) |

© Advanced Schedule &

Cancel

3. Enteravaluein the “Recur every” text box that specifies how often the schedule will occur. Values are:
® Hours:1to24
® Days:1-31
® \Weeks:1-4
® Months: 1-12

4. Select one of the following options from the dropdown list:

® Hours
® Days

® Weeks
® Months
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5. Click Save. The Simple schedule status is displayed in the Details panel.

Setting Up a Weekly Normalize Schedule

Set up a weekly normalize schedule:
1. Click the Details icon to open the Schedule panel.
2. Select the Advanced Schedule radio button. The Advanced Schedule dialog opens.

Figure 9-80: Advanced Schedule dialog

(X

Advanced Schedule

Start Date Start Time

Recurrence Pattern

Recur every I I Weeks - |

I~ Sunday I~ monday [~ Tuesday I~ ‘Wednesday [ Thursday
I~ Friday I~ Saturday

QK | Cancel

3. Click the Start Date field to choose a date from the calendar.

4. Click the Start Time field to choose a time from the time list.

5. Enter a numberin the Recur Every entry field. Values are 1-4.

6. Select Weeks from the dropdown list.

7. Select checkboxes for each day in the week that you want to run Normalize.

For example, to run Normalize every Monday and Thursday, enter 1 in the Recur Every entry field and place checks in
the Monday and Thursday checkboxes.

8. Click OK. The Advanced schedule status is displayed in the Details panel. Click the Edit icon to modify the schedule
settings.

Figure 9-81: Weekly Advanced Schedule Status
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& Simple Schedule

Recur every B0 I Day(s) |

& Advanced Schedule

Mext scheduled time: B/142014 3:33 P

Dccurs every 1 week(s). Effective 5721/2014 1:00am.

Setting Up a Monthly BDNA Normalize Schedule

Task Set up a monthly schedule:

1. Click the Details icon to open the Schedule panel.
2.

Figure 9-82: Monthly Schedule

start Date Start Time
512172014 |1:00am

Recurrence Pattern

Recur every |1
& 0n Day I1

" Last Day of the Manth

T The I First =] I Sunday d

]34 Cancel

3. Click the Start Date field to choose a date from the selection calendar.
4. Click the Start Time field to choose a time from the time list.
5. Enter a numberin the Recur Every entry field.

® \Values:1-12
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6. Select Months from the dropdown list.
7. Complete the steps for one of the following options.

a. Torun BDNA Normalize on a specific day of the month: Click the On Day radio button and enter a value in the
Day field. Values can be any whole number between 1 and 31.

b. Torun BDNA Normalize on the last day of the month: Click the Last Day of the month radio button to schedule
BDNA Normalize to run on the last day of the month.

c. Torun BDNA Normalize on a specific day according to its location on the calendar, complete the following
steps.

1. Click the bottom radio button.
2. Select aavalue from the Frequency drop-down list. The values are First, Second, Third, Fourth, Last.

3. Select avalue from the Day drop-down list. The values are Sunday, Monday, Tuesday, Wednesday, Thursday,
Friday, Saturday, Sunday.

For example, to run BDNA Normalize on the third Saturday of every month, choose Third and Saturday.
8. Click Save. The Advanced schedule status is displayed in the Details panel.

Figure 9-83: Monthly Advanced Schedule Status

& Advanced Schedule

Dccurs every 1 month(s). Effective 521/2014 1:00am.

Stopping a Normalization Operation in Progress

You can stop a normalization operation that is in progress by clicking Cancel on the BDNA Normalize panel.

Figure 9-84: Stopping a BDNA Normalize Operation

ACTRITY L) PrFaALTE o) PROCESS INETANCE CREATED. BOvENTORY D [ XNMENER TASK O e IET 4N CACEL
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Managing Settings

Use the BDNA Normalize Settings screens to review and edit information about any of the BDNA Normalize processes you
added to the Administration Console.

Accessing the Data Source and Process Settings
Screens

You can access two types of settings from the main screen of the Administration Console.
® Data Source Settings—Click the Edit icon located in the process’s Data Source pane.
® BDNA Normalize Processes—View and edit the data source name, type, and location settings.
® Purchase Order Processes—View and edit the data source name, type, and configuration settings..
® Data Mashup Processes—View and edit data source name, mashup source, and file settings.
®  Process Settings—Click the Settings link located on the right-side of the process Overview pane.
® BDNA Normalize and Normalize CM Processes —View and edit History, Metering, and Output Formats settings.
® Purchase Order Processes—View History and Output Format settings.

Figure 10-85: Accessing BDNA Normalize Data Source and Process Settings
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EE MNermalize CM 'S Detaily & Semings
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Source: M5SQL_ym-scomi | | Wi o5 EXCEL
— © Advanced Schedule #
== Data Mashup &
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Source; CAPrograrm Files)
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Add Data Source

-

== DEDUPFING RULES

Managing IT Discovery Tool, Data Mashup, and Purchase
Order Settings

Unless otherwise noted, the information below applies to both BDNA Normalize (IT Discovery Tool, Purchase Order, and
Mashup).

Note « Normalize CM is no longer available in BDNA Normalize.

Managing Data Source Settings

Data Source settings are organized under General, Data Source, and Authentication tabs. The Authentication tab is only
available for Normalize CM processes.

Viewing and Editing General Settings
The General settings provides the following information about the selected process:
® Data Source Name—The name that identifies the data source.

® Data Source Type—The discovery tool used by this process.
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Task To view and edit General data source settings:
1. Click the Edit icon located in the Data Source panel of the process overview pane.
2. Click the General tab.
3. To edit the settings, make any changes and then click Save.
4. To close the dialog box, click the X in the upper-right corner of the dialog.

Figure 10-86: Data Source Settings—General Tab—IT Discovery Tool Example

IT Discovery Normalize
Crverview of data source.

Data Source Name: En._q 2012

Data Source Type: [ \Microsoft System Center Configuration Manager 2012 j]

Viewing and Editing Database Data Source Settings
The Data Source settings provide the following information about the database.

® Radio buttons—View or edit the database type. Based on which IT Discovery tool is used in the process, one or more
radio buttons for the following database types are active: MSSQL, Oracle, DB2, MySQL, PostgreSQL, and Sybase. For
example, in Data Source Settings—Data Source Tab—Database Connection—MSSQL, only the MSSQL radio button is
active since the selected process uses ConfigMgr 2012 as its IT Discovery Tool.

® Configuration File—View or edit the configuration file used by the specified discovery tool.
® Configuration Fields—View or edit database configuration fields, as determine by the database type:
e MSSQL
® Server Name—View or edit the name of the database server.
® Database—View or edit the name of the database.
® Use Windows Authentication—Click the checkbox to enable Windows authentication.
® Oracle:

® Server Name—View or edit the name of the database server.
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® Port—View or edit the port used to connect to f the database.

® SID—Click this radio button to enable use of the System Identifier (SID) that identifies the database instance,
and then enter the system identifier (database name + instance number; e.g. database3).

® Service Name—Click this radio button to enable use of a ‘connector’ to one or more instances of the
database, and then enter the Service Name (e.g., sales. us.example. com).

DB2

® Server Name—View or edit the name of the database server.
® Port—View or edit the port used to connect to the database.
® Database—View or edit the name of the database.

MySQL

® Server Name—View or edit the name of the database server.
® Database—View or edit the name of the database.
PostgreSQL

® Custom File—Click Upload Config and select the custom file to be used for this process.
® Server Name—View or edit the name of the database server.
® Port—View or edit the port used to connect to the database.
® Database—View or edit the name of the database.

Sybase

® Server Name—View or edit the name of the database server.
® Port—View or edit the port used to connect to the database.

® Database—View or edit the name of the database.

® User Name—View or edit the authentication domain (MSSQL only) and/or username that enables access to the
database.
® Password—View or edit the username password that enables access to the database.
=
Task To view and edit database data source settings:
1. Click the Edit icon located in the Data Source panel of the process overview pane.
2. Click the Data Source tab.
3. Select the database radio button.
4. To edit the settings, make any changes, click Test Connection, and then click Save.
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5. Toclose the dialog box, click the X in the upper-right corner of the dialog.

Figure 10-87: Data Source Settings—Data Source Tab—Database Connection—MSSQL

Specity 0383 S0urte S 10C 300N Of Gt dveny Bocd.
B EAGL @ Cekcle O D02 @ 0L O PoitgreSil @ Svdade

Configuration Fee: | goomandractos config =|

Server aene 10,10, 1867

Detabase:  [oboc_sccm

User Name: 1@

Passwors  [ressessesene | Tast Connactinn |

(o e

Viewing and Editing Normalize Zip File Data Source Settings

The Data Source settings for a process that uses a zip file provides the file’s name, location, and (if the file is located on a
network server) the authentication credentials.

Task To view and edit BDNA Normalize ZIP file data source settings:

1. Click the Edit icon located in the Data Source panel of the process overview pane.

2. Click the Data Source tab.

3. To edit the settings, make any changes, and then click Save.
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4. To close the dialog box, click the X in the upper-right corner of the dialog.

Figure 10-88: Data Source Settings—Data Source Tab—Normalize ZIP File on Local Server

Browse and upload a local data source, or specify the location of a data source on a netwark or a Normalize server.

W Upload local data source

zp Fite: [CProgram FilesBONAWormalizeworkFoldertask_1¢ [NUBEsaZN

o e

Viewing and Editing CSV File Data Source Settings

The Data Source settings for a process using a CSV file provides the file’s name, location, the object to which it is linked, and
(if the CSV file is located on a network server), authentication credentials.

=
Task To view and edit CSV file data source settings:
1. Click the Edit icon located in the Data Source panel of the process overview pane.
2. Click the Data Source tab.
3. To edit the settings, make any changes, and then click Save.
112

Company Confidential BDNA-AG_550 BDNA Data Platform 5.5



Chapter 10 Managing Settings
Accessing the Data Source and Process Settings Screens

4. To close the dialog box, click the X in the upper-right corner of the dialog.

Figure 10-89: Data Source Settings—Data Source Tab—CSV on Local Server

Browse and upload a local data source, or specity the location of a data source on a network or a Normalze server,

Select an object o link the data fo: Machine :'I

F Upload local data source

File: [C\Program Files\BDMAMNormalizework ol _

Viewing and Editing ServiceNow Data Source Settings

The Data Source settings for a process using ServiceNow provides the ServiceNow instance URL, work folder location, and
authentication credentials for each.

Task To view and edit Service Now data source settings:

1. Click the Edit icon located in the Data Source panel of the process overview pane.

2. Click the Data Source tab.

3. Toedit the settings, make any changes, and then click Save.
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4. To close the dialog box, click the X in the upper-right corner of the dialog.

Figure 10-90: Data Source Settings—Data Source Tab—Service Now

General Data Source

Specify data source and location of discovery toal.

AR
Sendceho Instance URL:

[ https:/ /devo7q.service-now.com

Username: lbdna.admin

Passwort: [ ............  Test Comnection

—Servicetow Work Folder (UNC Path)-
Folder Path:

[ Y \wmodqw.bdnacorp.cominormalize-extracts$

Lser (domaimusername); [bdnacorp\buildqa

(L (R  Test Connection

Managing Process Settings

Process settings for IT Discovery Tool and Normalize CM processes are History, Metering, and Output Formats.

Viewing History Settings—IT Discovery Tool, Data Mashup Processes
Use this screen to accept or modify the inventory name, and/or to set a history mode.
® Inventory Name—Accept the pre-populated name or enter a new inventory name.
® History Mode—Click the radio button next to the setting you want to activate.
® Don’t Keep History—Always overwrite the most recent Normalization
® Keep History—Activate history for Analyze and/or Normalize
® |n Analyze—Activate Analyze history

® In Normalize—Activate Normalization history
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A

Caution - Selecting “Keep History” saves all inventory data to Analyze and/or Normalize. Depending on the number of
assets, saved inventories can grow very large and severely impact Data Platform application performance, especially

reporting and analysis. BDNA advises caution when setting “Keep History” values, and recommends monitoring saved
inventory sizes frequently.

®  Keep the last normalization of each—Place a check next to the schedule you want to activate.
®  Store the last Normalization of each Week
®  Store the last Normalization of each Month
® Store the last Normalization of each Quarter
®  Store the last Normalization of each Year
® Upto: 1-99 Weeks, Months, Quarters, or Years
=
Task To view and edit History settings:
1. Click the Settings link located on the right-side of the process overview pane.
2. Click the History tab.
3. To edit the settings, make any changes and then click Save.
4. To close the dialog box, click the X in the upper-right corner of the dialog.

BDNA Data Platform 5.5

Figure 10-91: Process Settings—History Tab

-]

Inventory Name:  JCM 2012

Hislory:
& Danl Keep History
© Keap History

Keep the last normahzation of each:
T wieek [ month [T Quarter [T Year
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Viewing History Settings—Purchase Order Processes

Use this screen to accept or modify the inventory name, and/or to set a history mode.

® History Mode—Click the radio button next to the setting you want to activate.
® Don’t Keep History—Always overwrite the most recent Normalization
®  Keep History—Activate history for Analyze and/or Normalize
Caution - Selecting “Keep History” saves all inventory data to Analyze and/or Normalize. Depending on the number of
assets, saved inventories can grow very large and severely impact Data Platform application performance, especially
reporting and analysis. BDNA advises caution when setting “Keep History” values, and recommends monitoring saved
inventory sizes frequently.
=
Task To view and edit History settings:
1. Click the Settings link located on the right-side of the process overview pane.
2. Click the History tab.
3. To edit the settings, make any changes and then click Save.
4. To close the dialog box, click the X in the upper-right corner of the dialog.
Figure 10-92: Process Settings—History Tab—Purchase Order
Normaliz:
Histary
Inventory Name:  JCOW_131121093508
Histony:
& Dont Keep History
 Keep History
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Viewing Metering Settings

Note » Metering settings are not available for Purchase Order processes.

Use this screen to view and edit when software is shown as being used. Metering options are dependent on the IT Discovery
Tool. If an IT Discovery tool does not provide metering information, the option will still be visible in the Ul, but will not be
available for use.

® |Installed date—Click this checkbox if you want to calculate the usage based on the installed date.

® Recently run—Click this checkbox if you want to calculate the usage based on the last run date.

®  Using software metering data—Click this checkbox to specify the rules that define what determines the “use” of

software. Click either radio button to specify the following:
The application is considered to be used if run over a specified number of minutes in the last specified number of
months.
The application is used a specified number of times in the last specified number of months.
Task To view and edit Metering settings:

1. Click the Settings link located on the right-side of the process overview pane.

2. Click the Metering tab.

3. To edit the settings, make any changes and then click Save.

4. To close the dialog box, click the X in the upper-right corner of the dialog.

BDNA Data Platform 5.5

Figure 10-93: Process Settings—Metering Tab

etering Output Farmat

The fallowing rules let you specify when software is shown as belng used.
F instalied date:

Installed day{s) ago.

™ Recently run;

Application has been used within days

¥ Using Software Metering data:

& The application is considered to be used, if run over minutes in the last 3 E months.

or

©If the application is used times over the past months .
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Viewing and Editing Output Format Settings
Use this screen to view and set the following output formats:
® BDNA Analyze—Click this checkbox to enable this type of output format.
®  Export results to CSV files—Click this checkbox to enable this type of output format.

® Directory on Normalize server (Disk space: XX MB)—Accept or edit the file location and available disk space.

Note « BDNA pre-defined SQL queries that output to CSV files are customizable and extensible. For more information, see
“Customizing CSV Results” in the BDNA Data Platform Installation and Configuration Guide.

Task To view and edit Output Format settings:
1. Click the Settings link located on the right-side of the process overview pane.
2. Click the Output Formats tab.

3. To edit the settings, make any changes and then click Save.
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4. To close the dialog box, click the X in the upper-right corner of the dialog.

Figure 10-94: Process Settings—Output Format Tab—IT Discovery, Mashup

Higtory | Metering | Migration

Wigw data in

™ BDMA Anatyze
I microsoft SOL Server Reporting Senices (SSRS)

F Export results to CSV files

Direclory on Mormalize server (Disk space: 19,1 91ME)

[CProgram Files\BEDNANomalizetResults

F Export results to Powerpivot for Excel

e ]

Figure 10-95: Process Settings—Output Format Tab—Purchase Order

Qutput Format

Wiew data in:

™ BONA Anatyze

¥ Export resuits to CSV files

Dirgctany on Normalize server (Disk space: 19,190MB)

[CProgram Files\EDNAMormalizetResults

Managing Data Source Settings

Data Source settings are organized under General and ConfigMgr Server tabs.
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Viewing and Editing General Settings

The General settings provides the following information about the selected process:

® Data Source Name—The name that identifies the data source.

® Data Source Type—The discovery tool used by this process.

®  Generate Package and Advertisement Automatically—Enables the automatic distribution of the Package and

Advertisement.

® Manual Distribution—Enables the manual distribution of the Package and Advertisement.
=
Task To view and edit General data source settings:

1. Click the Edit icon located in the Data Source panel of the process overview pane.

2. Click the General tab.

3. To edit the settings, make any changes and then click Save.

4. To close the dialog box, click the X in the upper-right corner of the dialog.

Viewing and Editing ConfigMgr Server Settings

The ConfigMgr Server settings provides the following information about the selected process:

® Server Name—The name that identifies the data source.

® User/Domain Name—The name used to access the ConfigMgr server.

® Password—The password used to access the ConfigMgr server.

® Site Code—The numerical identifier for the server.

® Site Name—The descriptive name for the server.

® Remove MOF Class—Deletes the MOF class file from the designated ConfigMgr server.
=
Task To view and edit ConfigMgr Server data source settings:

1. Click the Edit icon located in the Data Source panel of the process overview pane.

2. Click the ConfigMgr Server tab.

3. To edit the settings, make any changes and then click Save.
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4. To close the dialog box, click the X in the upper-right corner of the dialog.

Figure 10-96: Fingerprint Data Source Settings—ConfigMgr Server (no longer available)

Wiew or edit server and connection information,

Server Name,  jm-scomdt

User{domainiusemame); Imnmz.munr

Password: |. .......................

site code.  fon
Site Name:  fascowamacess

Managing Process Settings

Process settings for a Fingerprints process were organized under Credentials, Package, Advertisement, and Schedule tabs.
Fingerprints are no longer available.

Viewing and Editing Credential Settings
The Credential settings provides the following information about the selected process:
® Database Information—Read-only information about the database Host, Key, and Value.

® Add—Click the Add button to open a dialog to enter the following information: Database Credential Type, Host,
Username, and Password.

® Remove—Click the Remove button to delete a specific database credential.

Task To view and edit Credential settings:
1. Click the Settings link located on the right-side of the process Overview pane.
2. Click the Credential tab.

3. To edit the settings, make any changes and then click Save.
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4. To close the dialog box, click the X in the upper-right corner of the dialog.

Figure 10-97: Fingerprint Process Settings—Credentials (no longer available)

Credentials

“Wiew or edit fingerprint credentials_
“IMicrosolt SQL Server

> j T
Host | Koy | Walue
10A0AB 6T Aatrocs LieermamePasewond
10108 ET Lisernams au
10A0ATET Password MASALL

iCracle Database

Viewing and Editing Package Settings
The Package settings provides the following information about the selected process:
® Package Name—Name of the Fingerprints Package.
® Version—Read-only information about the Package version.

® Distribution Points—Checkbox to enable or disable distribution by the specified points.

Viewing and Editing Advertisement Settings
The Advertisement settings provides the following information about the selected process:
® Advertisement Name—Name of the Advertisement.
® Include Sub-collections—Checkbox to enable or disable including sub-collections.

® Collections—Drop-down list of collection to which the Fingerprints process is linked.

Task To view and edit Advertisement settings:
1. Click the Settings link located on the right-side of the process Overview pane.
2. Click the Advertisement tab.

3. To edit the settings, make any changes and then click Save.
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4. To close the dialog box, click the X in the upper-right corner of the dialog.

Figure 10-98: Fingerprint Process Settings—Advertisement (no longer available)

Advertizernant

View or edit acdvertisment name and collections.

Advertisement Name:  Fingarerirts
™ Include sub-collections
Collections: | a1 Systems =l

Viewing and Editing Schedule Settings
The Schedule settings provides the following information about the selected process:
® Start—Date to start automatic distribution of the Package and Advertisement.
® No Expiration—Checkbox to enable to disable ongoing distribution of the Package and Advertisement.
® Expire—Date to end automatic distribution of the Package and Advertisement.

® Assign Immediately After Event—Checkbox to enable or disable the distribution immediately after saving any
setting changes.

® Recurrence Pattern—Enable None, Weekly, Monthly, or Custom Interval distribution of the Package and

Advertisement. Selecting any option other than None will open a dialog that lets you specify frequency of the
distributions.

Task To view and edit Schedule settings:

1. Click the Settings link located on the right-side of the process Overview pane.

2. Click the Schedule tab.

w

To edit the settings, make any changes and then click Save.

4. To close the dialog box, click the X in the upper-right corner of the dialog.
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Monitoring BDNA Normalize

You can use the Administration Console to perform the following operations:

Viewing the Activity Monitor

Viewing Inventory Summary and Details
Viewing Inventory Results

Deleting Inventories

Viewing Normalize Statistics

Downloading Information from the Last Normalization

Viewing the Activity Monitor

The Activity Monitor provides details on recent Normalize processes and Catalog synchronizations.

©
Task To view Activity Monitor information:
1. Click the Activity Monitor “heartbeat” icon on the Administration Console to open the Activity Monitor (Activity
Monitor).
2. Torefresh activity date, complete the following steps.
a. Click the Auto Refresh checkbox to automatically update the Activity Monitor.
b. Enteranumberin the text field, using a two-digit format (for example, to specify 3 seconds enter 03).
c. Click Refresh.
3.

BDNA Data Platform 5.5

To view details about an activity item, click the relevant entry. Details about the selected entry display in the Activity
Details pane.

Figure 11-99: Activity Monitor
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BDNA N L Lo Loain: 722215 606 e
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Viewing Inventory Summary and Details

Task To view inventory:
1. Onthe Administration Console, open the BDNA Normalize page.

2. Click Inventory. The Inventory Summary screen opens to display a summary of processes, grouped by Inventory. The
screen is divided into two panes: Summary and Detailed View.

® |nventory Summary pane—provides the following information and/or options:
® Inventory ID—Unique ID number given to a specific Inventory.
® Inventory Name—Descriptive name given to the Inventory by the user.
® Status—Indicates whether the Inventory is in process or finished.
® Inventory Date—Date and time the Inventory was created.
® Results—Option to view results of the Inventory.
® Delete—Option to remove the selected Inventory.
® Detailed View—provides the following information and/or options:
® Normalization ID—Unique ID number given to the normalization.
® Normalization Process—Method used to normalize discovered data.

® Discovery Tool—Data source of the normalized data.
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® Status—Indicates whether the Inventory is in process or finished.

® Normalization Date—Data and time of the normalization.
® Delete—Option to remove the selected Inventory.
Figure 11-100: Inventory Summary and Details

Inventory Summary ?

View and manape inveniory results

summary of processes grouped by inventory, Select an inventory for a detailed view.

_ BOLO20_101025143822 — 201540812 123453

ATTREE0SE FINISH 2015-08-12 09:00-37 -

GOLD20_101025143822

Detailed view of inventory.

T N W T T

Viewing Inventory Results

Task To view inventory results:

1. Onthe Administration Console, open the Normalize page.

2. Click Inventory.

Click the Results icon for the Inventory whose results you want to view. The View Results screen opens, with options to
view results in various formats:

® Open BDNA Analyze—View and manipulate data in BDNA Analyze
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® Download CSV files—View data in a CSV format

Figure 11-101: View Results

View Results

Click icon to view resulis in specified format.

" / Open BDNA User Console Download CSV Files

Deleting Inventories

Task To delete inventories:
1. Onthe Administration Console, open the Normalize page.
2. Click Inventory.
3. Select the checkbox next to the Inventory (or Inventories) that you want to delete.
4. Click Delete Selected. A Confirmation message opens.

5. Click OK to confirm that you want to delete the selected Inventory.

Viewing Normalize Statistics

Task To view normalize statistics:

The Statistics page (BDNA Normalize Statistics—Enrichment) contains a summary of information about the most recent
normalization. Statistics are provided for:

® Extraction—Summary of extraction time, plus a summary and details on data sources.
® Normalize Process—Summary of processing time, plus summary and details on input/output.

® Normalize Enrichment—Summary of time, plus summary and details on input/output
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Task To view Normalize statistics:
1. Goto the BDNA Normalize panel of the Administration Console.

2. Click View Full Statistics for the process whose statistics you want to view. The Statistics page opens to the Extraction
view (BDNA Normalize Statistics—Extraction).

3. Click the Extraction, Normalize Process, or Normalize Enrichment navigation links to view details.

Note « The Data Platform Ul detects the configuration file (Norm.Configuration.config) to see if Tier 1 & 2 software
statistics are turned on or off. By default, it is set to ‘false.” Hence, users do not see Normalize statistics on Admin Console
page. Customers can still turn this functionality on by editing Norm.Configuration.config and setting values for
"StatsKeywordExec" and "StatsKeywordAddremove" to ‘true’ if they want to see Tier 1 & 2 software statistics on both the
Normalize Results section of the Admin Console page and the Full Statistics pop-up window.

Figure 11-102: BDNA Normalize Statistics—Extraction

Technopedia Normalize Statistics
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Figure 11-103: BDNA Normalize Statistics—Normalize Process
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Figure 11-104: BDNA Normalize Statistics—Enrichment
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Downloading Information from the Last Normalization

Information from each normalization is automatically saved on the server, if you choose the Export Results to CSV files
checkbox on the Output Format tab. The information from the most recent Normalization is contained in the
PreviousResults.zip file, with the contents as shown in <Z_Hyperlink>Figure . The zip file includes an Excel file (.xls) that
contains a description of each of the CSV files.

Task To download results from the last Normalization:
1. Open the Administration Console.

2. Click the CSV label for the BDNA Normalize process whose results you want to download. A File Download dialog
opens.

3. Click Save to download the Results*.zip file.

4. Browse to identify a location.
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5. Click Save.

Figure 11-105: Contents of the Download Zip File

Bl Results_BDNA_122820133_11221246.zip
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= | Program Files L normakze_results_col_defs.xls LS File
= | BODNA | MormakzeHardveare .csw L5V File
= | Technopedia Normalize | MormalizeHardwarelfeCycle.csvw 5V File:
J Ein | MormslizeHardvwareMapping.csv 5V File
o c“":'c""" | NormsiizeHardwarespecifications.csw  CSV File
\ Conl :
@ i ConsoleExtension | MormalizeSoftware, csv 5V File
% | Databace . MormahizeSoftwarelLifeCycle.csv C35V File:
| Fingerprinks | MormahizeSoftwareMapping.csv 5 File
L by | MormalizeSoftwaraSuite, csw CSV File
® . NormalizeConsole __| MormalizeSoftwarewin7Rie adiness. csv C5¥ File
B e Reports | OweraliStatistics. csv 5V File
2l Rest.#s __ Peraddremave.csv C5V File
| PersddremaveManuf acturer .csv 5V File
__ PeraddRemaveTier.csv 5V File:
. PerExecutable.csv 5V File
= | Common Files LI €| | _>|
Catalog Terminology
The following table shows the terms and definitions that are used in the catalog files.
Table 11-3 « Catalog Terms and Definitions

Term Definition Used in File(s)...

Unmatched The entry doesn't exist in the catalog. Unmatched_*.zip -> Unmatch_*.csv
(This file is uploaded to bdna.com
during synchronization.)

NoRef The entry exists in the catalog, but it either has not Unmatched_*.zip -> Noref_*.csv

been mapped nor has it been marked as Irrelevant.

(This file is uploaded to bdna.com
during synchronization.)
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Used in File(s)...

Irrelevant The entry exists in the catalog, but itis consideredtobe  PerAddRemove_*.csv
irrelevant, hence ignored. A reason is associated with PerExecutable_*.csv
the Irrelevant entry. OverallStatistics_*.csv

Mapped The entry exists in the catalog, and has been mapped PerAddRemove_*.csv
to a proper catalog product. PerExecutable_*.csv

OverallStatistics_*.csv

Known The entry exists in the catalog, and it either has been OverallStatistics_*.csv
mapped or has been marked as Irrelevant
(Mapped+lrrelevant).

Unknown The entry either exists or doesn't exist in the catalog, PerAddRemove_*.csv

and it either has not been mapped or has not been
marked as Irrelevant (Unmatched+NoRef).

*

PerExecutable_*.
OverallStatistics_*.

csv
csv

Unmatched Data Files

Unmatched files refer to zip package files that are generated by a Normalize process and stored locally (where Normalize is

installed). The name of the zip package file uses the following naming convention:

Unmatched_[Company_Identifier]_timestamp_[task_id]

For example: Unmatched_ACMECompany_1704222148_16752.zip

Note « With the latest release of Normalize, the Company Identifier now uses the Org GUID (HASH) characters (as opposed to
plain text).

This Unmatched zip package file contains multiple csv files:

BDNA Data Platform 5.5

AddRemove_Unmatch_Detail_[task_id]

BIOS_Unmatch_Detail_[task_id]

CPU_Unmatch_WithHardware_Detail_[task_id]

Exe_Unmatch_Detail_[task_id]

GR_AddRemove_Unmatch_Detail_[task_id]

GR_Exe_Unmatch_Detail_[task_id]

HW_Unmatch_Detail_[task_id]

0S_Unmatch_Detail_[task_id]

BDNA-AG_550
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The first argument in those file names indicate which table in the Normalize schema the data comes from (i. e. from
AddRemove table, BIOS table, Exe table, and so on). Note that there are some files that are prefixed with a GR_ string to
indicate that the file contains usage metering data (if it's enabled in the discovery tool). Every file contains the
'Unmatch_Detail' argument, and is suffixed by the task ID.

Each of the Unmatch_Detail files contain the 'unmatched' entries (i.e. entries that contain no matching string in the
existing BDNA Normalize mapping signatures). For example, the AddRemove_Unmatch file contains entries from the
AddRemove table in Normalize that returns no match with any mapping signature. This happens in this instance because
Normalize has never seen any data that matches this exact string in the past. As a consequence, these entries will return
neither Technopedia data nor the indication that it is 'Irrelevant’ in Normalize reports. Customers generally would like to
see the entries to be either 'Mapped' or marked as 'Irrelevant’, therefore they may choose to (optionally) have them go
through the 'gap-fill' process.

Figure 11-106: Sample of an Unmatched File:

MNetwork » nas3 » shared » ga » dp » unmatched files >|Unmatched_qatatkey}_S?__‘l702101401_16?59

-

[ Mame Type Compressed size Password ... | Size
AddRemove_Unmatch_Detail_16759 Microsoft Excel Comma Separated Values File 12KB Mo 68 KB
BIOS_Unmatch_Detail_16759 Microsoft Excel Comma Separated Values File 1TKE Mo 1KBE
CPU_Unmatch_WithHardware_Detail_16759 Microsoft Excel Comma Separated Values File TKE Mo 1KB
Exe_Unmatch_Detail_16759 Microsoft Excel Comma Separated Values File 940KE Mo 7,862 KB
GR_AddRemove_Unmatch_Detail_1675% Microsoft Excel Comma Separated Values File 2KB Mo 3KB
GR_Exe_Unmatch_Detail_16739 Microsoft Excel Comma Separated Values File 101KE Mo 687 KB
HW_Unmatch_Detail_16739 Microsoft Excel Comma Separated Values File TKE Mo 1KBE
05 _Unmatch_Detail_16759 Microsoft Excel Comma Separated Values File 1TKE Mo 1KB

What Happens to the Unmatched File

134

The unmatched file is generated automatically with every Normalize task. The Normalize Ul provides the information
about where the unmatched file is stored (locally). The settings in the Normalize Ul also provide the option for the user to
automatically send the unmatched file to BDNA every time a Technopedia sync is being performed. Note that the default
option is checked, meaning the unmatched file will be sent automatically.

When the sync button is clicked, the unmatched file will be transmitted to the BDNA's Technopedia Update Server (TUS)
over a SSL-encrypted connection.

Note that some customers may choose to send the unmatched file manually (i.e. via their own secure transmission process
or via BDNA's Customer Support Portal). These customers set the option in Normalize Settings by un-checking the button
in order to send the unmatched file automatically.
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The TUS lives within BDNA's secure AWS environment and is only accessible to select BDNA personnel with certain
credential levels. Most of the time, access to the TUS is done via a secure automation process that monitors the TUS
periodically. This is done in order to detect any new unmatched file that gets uploaded and to pick the unmatched file(s) to
be processed via the gap-fill.

Figure 11-107: Update Process
Nurrﬁgﬁ;%r:?new TUS Server Mormalize Gap-fill
job (Amazon Cloud) FProcess

Normalize Gap-fill Process

Normalize gap-fill process refers to the process of reviewing 'Unknown' entries from the Normalize result and turning them
into 'Known' entries (either '"Mapped' or 'Irrelevant').

Some definitions around the Normalize gap-fill:
® Known: Data that have been identified in Normalize (as represented by either the 'Mapped' or 'lrrelevant’ signatures).

® Mapped: Mapping signatures where the discovered data is mapped to Technopedia entries. This represents the
'Relevant' data, as well as raw data that has been deterministically identified and is aligned to Technopedia.

® Irrelevant: This represents the signatures where the discovered data has been identified and deemed to be not
relevant in order to identify the assets. While irrelevant data is not discarded, it's filtered out to remove the 'noise'
created by all the extraneous data.

® Unknown: This represents raw data that has not been processed by BDNA Normalize. It's either completely new data
or existing data that has not been categorized as either 'relevant’ (i.e. Mapped) or 'irrelevant’ (i.e. marked as
'Irrelevant'). This is subject of the “gap-fill” process. Note that there may still be potentially entries that remain
'unknown' (typically customer developed custom software that can be identified and mapped using the BDNA Private
Catalog capability) or it may be data that falls outside the SLA, which most of the time represents items that
contribute little or nothing regarding the identification of an asset.

. Normalize Reports P :
Technopedia Normalize Dls_covery Tools )
5 Mapped < SE— Tiers in Technopedia

Product IDs J | Koo ‘ e
< _ - packages, files

Irrelevant -+ .

Release IDs ) ' g {i.e. SCCM, ADDM)
- Unknown ‘
Unknown (in-
progress, outside
SLA)

MNormalize Gap-fill
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Unmatched Data Resolution Goals (SLAs)

Normalize Unmatched Data Resolution Goals

® BDNA will provide Gap-fill for all Unmatched Data from customer's Data Source for Tier 1 and Tier 2 vendors (as
specified in the Technopedia Catalog) within 30 days.

®  BDNA will provide Gap-fill for any Unmatched Data from a customer's Data Source for any Tier 3 vendor (with more
than twenty installations of a single product) within 30 days.

®  For large submissions of initial Unmatched Data, BDNA will provide an estimate for Gap-fill within 3 business days.
Customer must submit a support incident in order to request this estimate.

P.0. Normalize Unmatched Data Source Resolution Goals

The P.O. Data Source is defined as the purchasing or procurement tool from which purchase order data is extracted in
order to be normalized. Unmatched P.O. data refers to purchase order data from a P.O. Data Source for hardware and
software purchases that are not successfully normalized by BDNA P.O. Normalize (excluding accessories, services, etc.).

® BDNA will Gap-fill all Unmatched P.O. Data from a customer's P.O. Data Source (for Supported Vendors) for up to 2,000
purchase orders no later than 30 days after BDNA receives the data.

® For large initial blocks of Unmatched P.O. Data, BDNA will Gap-fill all Unmatched P.O. Data from a customer's P.O.
Data Source with the following schedule:

® Upto 5,000 POs: 2 Months.
® Upto 10,000 POs: 4 Months.
® Upto 20,000 POs: 6 Months.

® More than 20,000 POs: Contact BDNA for more information.

136 Company Confidential BDNA-AG_550 BDNA Data Platform 5.5



Extracting Additional Data from an IT
Discovery Tool

Adding a pass-through configuration file to an IT Discovery Tool process lets you extract additional data from that tool.
There are two types of pass-through files:

® Pass-through inputs of specific data from your discovery data source that is not included by default.
® Pass-through_A data adds or imports additional attributes related to software from your discovery data source.

To enable the processing of a pass-through configuration file, you must first create a Pass-through or Pass_through_A
configuration file that contains the instructions necessary to retrieve the data from the data source you are using as a pass-
through. We have provided examples of a Pass-through and Pass-through_A configuration file.

After you create the applicable configuration file, you can add it as a data source of an IT Discovery process.

Customizing a Configuration File

In this section you will find two examples of customized configuration files that you can use as a basis for building your own
configuration file. The examples are:

® Example 1: Pass-through Configuration File—Use this type when you want to input specific data from your discovery
data source that may not have been included by default.

® Example 2: Pass-through_A Configuration File—Use this type when you want to add/import attributes related to BDNA
Normalize.

Note « The customizable portions of the files are color-coded.

The configuration files also include standard XML entries, which have been truncated to save space.

Example 1: Pass-through Configuration File

<?xml version="1.0" encoding="utf-8" ?>
<configuration LoaderConfig="disc4_ loader_config 201304" Disc_Source="DISCOVER">
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<Connection Type="ORACLE">
<Property Name="Host" Value=""/>
<Property Name="Service Name" Value=""/>
<Property Name="User ID" Value=""/>
<Property Name="Password" Value=""/>
<Property Name="Port" Value="1521"/>
</Connection>

<Tables>
<Table Type="AddRemove">
<SQL>
<! [CDATA[

««

»

11>
</SQL>
</Table>

[

»

<Table Type="Pass-through" Name="MU_HOST" Dynamic_subtype="Machine" Label="Discovered CPU">

<Fields>
<Field Name="MachineID" DataType="NVARCHAR(255)" Nullable="1" DefaultValue=""
Comment="" Key_ Position="1" FileColumnName="Key-MachineID:MachineID" />

<Field Name="NUMCPUS" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key_Position="0" FileColumnName="NUMCPUS" />
<Field Name="NUMCORES" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" Comment=""
Key_Position="0" FileColumnName="NUMCORES" />
</Fields>

<SQL>
<! [CDATA[
SELECT
MachineID as "Key-MachineID:MachineID",
NUMCPUS,
NUMCORES
FROM (
SELECT DISTINCT
C.OPERATINGSYSTEM_ID as MachinelD,
COUNT(c.CPU_ID) as NUMCPUS,
SUM(cpu.CORES) as NUMCORES
FROM BDNA_CPUS c
INNER JOIN BDNA_INV_CATALOG_MAP m ON c.operatingsystem id=m.inv_asset_id
AND c.inventory _id = m.inventory_id
INNER JOIN BDNA_HW_CPU_INFO cpu ON m.cpu_id = cpu.hw_cpu_id
INNER JOIN (
SELECT OPERATINGSYSTEM_ID, INVENTORY_ID FROM BDNA_ALL_OS WHERE
LEVEL2="Y' AND INVENTORY_ID IN (SELECT MAX(INVENTORY_ID) FROM BDNA_INVENTORY_INFO)
JRON R.OPERATINGSYSTEM_ID=c.OPERATINGSYSTEM_ID
AND R.INVENTORY_ID=c.INVENTORY_ID
GROUP BY c.operatingsystem id
)T
11>
</SQL>
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</Table>
</Tables>
</configuration>

Example 2: Pass-through_A Configuration File

<?xml version="1.0" encoding="utf-8" ?>
<configuration LoaderConfig="disc4 loader_config 201304" Disc_Source="DISCOVER">

<Connection Type="ORACLE">
<Property Name="Host" Value=""/>
<Property Name="Service Name" Value=""/>
<Property Name="User ID" Value=""/>
<Property Name="Password" Value=""/>
<Property Name="Port" Value="1521"/>
</Connection>

<Tables>
<Table Type="AddRemove">
<SQL>
<! [CDATA[

173

»

1>
</SQL>

</Table>
<Table Type="Pass-through_A">

<Fields>
<Field Name="installdirectory" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" />
<Field Name="isrunning" DataType="NVARCHAR(255)" Nullable="1" DefaultValue="" />
</Fields>

<SQL>
<! [CDATA[
SELECT

BDNA_FP_APPS.OPERATINGSYSTEM_ID as ResourcelD,

BDNA_TYPES.FULL_TYPE_NAME || '.' || REPLACE((CASE WHEN
BDNA_FP_APPS.APPLICATION_EDITION IS NOT NULL THEN BDNA_FP_APPS.APPLICATION EDITION END),' ',' ') as
ProdID,

CASE WHEN BDNA_FP_APPS.APPLICATION_EDITION IS NULL THEN BDNA_TYPES.TYPE_LABEL ELSE
BDNA_TYPES.TYPE_LABEL || ' ' || BDNA_FP_APPS.APPLICATION _EDITION END as DisplayName,

BDNA_FP_APPS.MANUFACTURER as Publisher,

BDNA_FP_APPS.APPLICATION_VERSION as Version,

null as InstallDate,

installdirectory as installdirectory,

isrunning as isrunning

FROM BDNA_FP_APPS
INNER JOIN BDNA_TYPES ON BDNA_TYPES.TYPE_ID=BDNA_FP_APPS.APPLICATION_TYPE
INNER JOIN (

SELECT OPERATINGSYSTEM_ID, INVENTORY_ID FROM BDNA_ALL_OS WHERE LEVEL2='Y' AND

INVENTORY_ID IN (SELECT MAX(INVENTORY_ID) FROM BDNA_INVENTORY_INFO)
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)R ON R.OPERATINGSYSTEM_ ID=BDNA_FP_APPS.OPERATINGSYSTEM_ID
AND R.INVENTORY_ID=BDNA_FP_APPS.INVENTORY_ID

1>
</SQL>

</Table>

««

»

</Tables>
</configuration>
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Objects and Mapping Fields

This section provides reference tables for all available Objects and Mapping Fields that can be used for Data Mashup, Pass-
Through, and Purchase Orders. The tables provide the following information:

TABLE_TYPE—How the data is brought into the system, based on process type.
OBJECT_NAME—The object to which you want to attach the data.
TABLE_NAME—The short name for the physical table.

KEY_ITEM—A list of available mapping fields for a specific object.

LIMIT_LIST—Indicates a limitation. For example, some fields cannot be standalone—they must be associated with
other fields.

Reference tables for Objects and Mapping Fields

The following tables show objects and mapping fields:

Purchase Order

Table B-4 « Purchase Order

Objects Fields Notes
TABLE_TYPE PurchaseOrder

OBJECT_NAME PurchaseOrder

TABLE_NAME PO

BDNA Data Platform 5.5
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Table B-4 « Purchase Order (cont.)

Objects Fields Notes
KEY_ITEM KEY NOTES
Mfr_Part_No
Manufacturer
PRODUCT_DESC
UNIT_OF_MEASURE
OTHER_INFO
Reseller
SKU_No
Quantity Not a mapping field; only used as meta-data.
Unit_Price Not a mapping field; only used as meta-data.
Total_Price Not a mapping field; only used as meta-data.
Start_Date Not a mapping field; only used as meta-data.
LIMIT_LIST LIST NOTES

SKU_No,Reseller

Mfr_Part_No,Manufacturer

Mfr_Part_No,PRODUCT_DESC

Mfr_Part_No,SKU_No,Reseller

PRODUCT_DESC

PRODUCT_DESC,Manufacturer

PRODUCT_DESC,
UNIT_OF_MEASURE

PRODUCT_DESC, OTHER_INFO
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Machine

Table B-5 « Machine

Appendix B Objects and Mapping Fields
Reference tables for Objects and Mapping Fields

Objects Fields Notes
TABLE_TYPE Mashup, Pass-
through
OBJECT_NAME Machine
TABLE_NAME MU_HOST
KEY_ITEM KEY NOTES
Hostname
Domain Domain cannot be used as a single mapping key.
It must be associated with Hostname
Domain\\Hostname | Double backslash ("\\") is a required escape sequence in an XML file.
The escape sequence is not necessary in a CSV file.
IPAddress
MachinelD
SerialNumber
LIMIT_LIST LIST NOTES
Hostname

Domain\\Hostname

IPAddress

MachinelD

SerialNumber

Domain,Hostname

BDNA-AG_550
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User

Table B-6 « User

Software

144

Objects Fields Notes

TABLE_TYPE Mashup, Pass-
through

OBJECT_NAME User

TABLE_NAME MU_USR

KEY_ITEM KEY NOTES
Domain Domain cannot be used as a single mapping key.

It must be associated with Username
Domain\\Username | Double backslash ("\\") is a required escape sequence in an XML file.
The escape sequence is not necessary in a CSV file.

Username

LIMIT_LIST LIST NOTES
Domain\\Username
Username
Domain,Username

Table B-7 « Software

Objects Fields Notes

TABLE_TYPE Mashup, Pass-
through

OBJECT_NAME Software

TABLE_NAME MU_SW
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Table B-7 « Software (cont.)

Objects

KEY_ITEM

Fields

KEY

Notes

NOTES

Appendix B Objects and Mapping Fields
Reference tables for Objects and Mapping Fields

ReleaselD

ProductID

VersionID

VersionGrouplID

EditionID

LIMIT_LIST

LIST

NOTES

ReleaselD

ProductID

VersionID

VersionGrouplID

EditionID

Hardware

Table B-8 « Hardware

Objects

TABLE_TYPE

Fields

Mashup, Pass-
through

Notes

OBJECT_NAME

Hardware

TABLE_NAME

MU_HW

KEY_ITEM

KEY

NOTES

ProductID

ModellD
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Table B-8 « Hardware

Objects Fields Notes
LIMIT_LIST LIST NOTES
ProductID
ModellD
Table B-9 - OS
Objects Fields Notes
TABLE_TYPE Mashup, Pass-
through
OBJECT_NAME (O
TABLE_NAME MU_OS
KEY_ITEM KEY NOTES
ReleaselD
ProductID
VersionlD
VersionGrouplID
EditionID
LIMIT_LIST LIST NOTES
ReleaselD
ProductID
VersionlD

VersionGrouplID

EditionID
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CPU

Table B-10 - CPU

Objects Fields Notes

TABLE_TYPE Mashup, Pass-
through

OBJECT_NAME CPU

TABLE_NAME MU_CPU

KEY_ITEM KEY NOTES
ModellD

LIMIT_LIST LIST NOTES
ModellD

Manufacturer

Table B-11 « Manufacturer

Objects Fields Notes
TABLE_TYPE Mashup, Pass-
through
OBJECT_NAME Manufacturer
TABLE_NAME MU_MFR
KEY_ITEM KEY NOTES

ManufacturerlD

LIMIT_LIST LIST NOTES

ManufacturerlD

Note « Other object has no definition—it is used to import any external data; no specific keys are required.The
Manufacturer object is not used in the current version of BDNA Normalize
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Dissecting a Configuration File

Configuration File Dissection

This section provides a detailed explanation of the values required in the customizable sections of a configuration file. The
sections shown here include:

® Header
® Fields
® SQL Query

For a detailed reference of Objects and Mapping Fields, see Appendix B.
Values are provided for the following:
® TABLE_TYPE

® OBJECT_NAME

® TABLE_NAME
® KEY_ITEM
® LIMIT_LIST

The customizable portions of the files include:
® Standard XML file entries

® Headers

® Fields (labeled as <fields>)

® Truncated (portions often indicated with empty quotes “ ”)
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Header
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A header defines the type of objects/tables to be imported into Normalize.

<Table Type="XXXXX" Dynamic_subtype="YYYYY" Name="ZzZ7Z" Label="WWWWW">

</Table>

Where XXXXX is one of the following TABLE_TYPE:

Values:

® Mashup

® Pass-through

® Pass-through_A
® PurchaseOrder

Where YYYYY is one of the following OBJECT_NAME:

Values if XXXXX is “Mashup” or “Pass-through”:

Machine
User
Software
Hardware

0S

CPU
Manufacturer

Other

Value if XXXXX is “PurchaseOrder”:

PurchaseOrder

Value if XXXXX is “Pass-through_A":

Where ZZ7Z7Z is one of the following TABLE_NAME:

Value if YYYYY is “Machine”:

MU_HOST

Value if YYYYY is “User”:

MU_USR

Value if YYYYY is “Software”:

MU_SW

Value if YYYYY is “Hardware”:

MU_HW
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® Valueif YYYYYis “OS™:
® MU_OS
® Valueif YYYYYis “CPU”:
e MU_CPU
® Valueif YYYYYis “Manufacturer”:
® MU_MFR
® Valueif YYYYis “Other”:
® OTHER (Orany name limited to 14 characters.)
® Valueif YYYYYis “PO™:
e PO
®  Value if XXXXX is “Pass-through_A":
NOT AVAILABLEWhere WWWWW is one of the following labels for a table:
® Values:
® Free Text—30-character maximum.
® [f Analyze is activated:

® The Label will be used as a Dimension name for all objects except
“Other”, “Manufacturer”, and “PurchaseOrder”.

Note - If TABLE_NAME is “Other’, a dynamic view is created in the Publish database. This dynamic view inherits the
name of the value defined in the LABEL field.

Fields

This section describes each field to be imported into Normalize, and whether or not a field is used as a mapping field.

Note « For Pass-Through_A you should not add a definition for the standard fields: +ResourcelD, +ProdID, +DisplayName,
+Publisher, +Version, +InstallDate

<Fields>

<Field Name="XXXXX" DataType="YYYYY" Nullable="Z" DefaultValue="" Comment="" Key_Position="W"
FileColumnName="VWW" />
</Fields>

Where XXXXX is the name of the KEY_ITEM.KEY:
e [fWis“1l”
® Values if Dynamic_subtype is “Machine”:

® Hostname
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® Domain
® Domain\\Hostname
® |PAddress
® MachinelD
® SerialNumber
® |imitation:

® “Domain,Hostname”

Note « You can only have one mapping field at a time, except for the one specified in the Limitation section. A limitation

is the first field, which cannot be used without the second. In the example use case shown above, Domain cannot be used

without Hostname.
® Values if Dynamic_subtype is “User”:
® Domain
® Domain\\Username
® Username
® Limitation:
® “Domain,Username”
® Values if Dynamic_subtyp is “Software”:
® ReleaselD
® ProductID

® VersionlD

VersionGrouplD

EditionID
® Values if Dynamic_subtype is “Hardware”:
®  ProductID
® ModellD
® Values if Dynamic_subtype is “OS™:
® ReleaselD
®  ProductIiD

® VersionID

VersionGrouplD

EditionID

® Valueif Dynamic_subtype is “CPU”:
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® ModellD
® Valueif Dynamic_subtype is “Manufacturer”:
®  ManufacturerlD
® \Valueif Dynamic_subtype is “Other”:
® NOT AVAILABLE
® Values if Dynamic_subtype is “PurchaseOrder”:
®  Mfr_Part_No
® Manufacturer
® PRODUCT_DESC

® Unit_of_Measure

® Other_Info
® Reseller

® SKU_No

® Quantity

® Unit_Price

® Total_Price

® Start_Date
® Limitation:

® "SKU_No,Reseller"

® "Mfr_Part_No,Manufacturer"

® "Mfr_Part_No,PRODUCT_DESC"

e "Mfr_Part_No,SKU_No,Reseller"

® "PRODUCT_DESC"

® "PRODUCT_DESC,Manufacturer"

® "PRODUCT_DESC,Unit_of_Measure"

® "PRODUCT_DESC,Other_Info"

Where YYYYY is the type of the physical column in Publish DB:

® Values:

® NUMERIC

® NVARCHAR(255)

® DATETIME
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Note « For OBJECT_NAME (Machine, User, Software, Hardware, OS, CPU, Manufacturer), you must use the same data
type (NUMERIC, NVARCHAR, DATETIME) for all columns—excluding the matching key.

Where Z defines whether the field can be NULL or NOT:
® Values:
® |f0thefield can be NULL
® [f1thefield CANNOT be NULL
Where W defines whether the field is used as a matching key or not:
® Values:
® [f0thefield is not used for Matching

e [f1thefieldisused for KEY_ITEMS.KEY

Where VWV is the name of the column returned by the SQL Query:

® \Value:

® Name of the column returned by the SQL Query

SQL Query

This is the SQL Query to be run against the data source that extracts the data and imports it into Normalize.

<SQL>
<! [CDATA[XXXXX]>
</SQL>

Where XXXXX is the SQL Query run against the data source.

The query will return the same number of columns as the number of fields defined in the above Fields section except in
Pass-through_A, where ProdID, DisplayName, Publisher, and Version are not defined in the Field section. Each column

should return the same name as defined in FileColumnName.
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ADDM Extractor Setup

This appendix provides step-by-step instructions on how to enable BDNA Normalize processing of data from a BMC Atrium

Discovery and Dependency Mapping database (ADDM). In order for BDNA Normalize to process the ADDM data, you must
first export it into an MS SQL database using the ADDM Exporter.

Using the ADDM Exporter

ADDM provides functionality to export native data to an RDBMS or CSV format. The following instructions show how to
export ADDM data into either of these formats.

1. Inthe ADDM console, navigate to Administration > Export

2. Create a new Mapping Set:

a. Select the “Mapping Sets” tab.

b. Create a new Mapping Set named “normalize-mapping-set”.
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Note « Normalize requires a specific set of fields from ADDM. Several of those fields are not in the standard “extended-

rdv-mapping-set”

Table D-12 « Required fields

Used by In Standard
OBJECT_NAME COLUMN_NAME Normalize Mapping-Set
HOST_CI DOMAIN Yes Yes
HOST_CI HOST_HOSTNAME Yes Yes
HOST_CI HOST_KEY Yes Yes
HOST_CI HOST_KEY_HASH Yes Yes
HOST_CI LAST_UPDATE_SUCCESS Yes Yes
HOST_CI MODEL Yes Yes
HOST_CI NUM_LOGICAL_PROCESSORS Yes Yes
HOST_CI NUM_PROCESSORS Yes Yes
HOST_CI 0S Yes Yes
HOST_CI OS_EDITION Yes Yes
HOST_CI OS_VERSION Yes Yes
HOST_CI PARTITION Yes No
HOST_CI PROCESSOR_SPEED Yes Yes
HOST_CI PROCESSOR_TYPE Yes Yes
HOST_CI RAM Yes Yes
HOST_CI SERIAL Yes Yes
HOST_CI VENDOR Yes Yes
HOST_CI VIRTUAL Yes No
PACKAGE_CI PACKAGE_DESCRIPTION Yes No
PACKAGE_CI PACKAGE_KEY_HASH Yes Yes
PACKAGE_CI PACKAGE_NAME Yes Yes
PACKAGE_CI PACKAGE_OS Yes Yes
PACKAGE_CI PACKAGE_VERSION Yes Yes
PACKAGE_CI VENDOR Yes No
PACKAGE_HOST_REL HOST_KEY_HASH Yes Yes
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Table D-12 « Required fields
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Used by In Standard
OBJECT_NAME COLUMN_NAME Normalize Mapping-Set
PACKAGE_HOST_REL PACKAGE_KEY_HASH Yes Yes
SI_CI EDITION Yes Yes
SI_CI PUBLISHERS Yes No
SI_Cl SI_KEY_HASH Yes Yes
SI_Cl SI_TYPE Yes Yes
SI_CI SI_VERSION Yes Yes
SI_HOST_REL HOST_KEY_HASH Yes Yes
SI_HOST_REL SI_KEY_HASH Yes Yes

Figure D-108: Mapping Set tab
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Import the following files into the new mapping set:

® host.xml

® sixml

® package.xml

Note « The .xml files listed here are included with this .pdf file as Attachments. For those viewing the online help, the .xml
files can be obtained from the .pdf version of the BDNA User Console User Guide.

Create a new ADDM SQL Server database.

Execute the following script on the new SQL Server database:
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® Normalize-ADDM-Exporter-(MSS).sql

Note « The .sqlfile listed here is included with this .pdf file as an Attachment. For those viewing the online help, the .xml
files can be obtained from the .pdf version of the BDNA User Console User Guide.

Select the “Adapter Configurations” tab.

Figure D-109: Adapter Configurations tab
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Click Edit to edit the Adapter Configuration.
Select the Microsoft SQL Server (JTDS Driver) in the Database Driver drop-down.

For more information about adding new drivers, click here: http://discovery.bmc.com/confluence/display/83/
RDB+adapter+-+Adding+a+new+JDBC+driver

Enter a Connection URL using the required syntax. For example:
jdbc:jtds:servertype://server[:port][/database][;property=value][;property=value]

Figure D-110: Editing the adapter configuration
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10. Select the “Exporters” tab.
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11. Create a new Exporter named “Normalize”.

Figure D-111: Exporters tab
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12. Select the new Adapter Configuration and the new “normalize-mapping-set”.

Figure D-112: Adapter Configuration and Mapping Set

Exports |'Am" fguiations | Mapping St |
[ [ | Reee ]

Exporter Detuils
Description: nomatioe
Exporting: A tams
Last Exported: Mon Feb 11 15,00 %4 GUIT 2013
Adapter Configuration
Name: L)l
‘Descriphon: it
Write bo the manidest tabie: yes
Pasaweond: —
JOBL Conessction URL: e P sgipenaer 182 168 5 150 14ADDMD
Dalabase Drvver: MICIDES® SOL Senr JTIOS D 122
Unermarne: -
- Sot- = o
Nama Detcriiten
host Expart Hosts and fher 51 relationships
package Esport Packages and her Hosts reabionzhips
s EXpart St and thsr relationahips

13. Run the Normalize Exporter.

Connecting the BDNA Normalize Extractor

Once the data has been exported, you can connect the BDNA Normalize Extractor to the new ADDM SQL Server database
using the “addm.extractor(MSS).config” configuration file.
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Converting a Custom 4.x Extractor
Configuration

If you have been using a Normalize 4.x custom configuration file to extract data from any of the data sources listed in the
table below, you will need to convert the format of the configuration file to conform to the BDNA Data Platform standard
format.

Custom4.x Extractor Conversion

Data sources and configuration files that must be converted to Data Platform format:

Table E-13 .«
BMC ADDM ® addm.extractor (MSS).config
® addm.trial.extractor (MSS).config
HP DDMA ® hpddma.extractor (MSSQL).config

® hpddma.extractor (ORA).config

® hpddma.schema_name.extractor (ORA).config

® hpddma.schema_name.trial.extractor (ORA).config
® hpddma.trial.extractor (MSSQL).config

® hpddma.trial.extractor (ORA).config
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Table E-13 «

Data Source Configuration file

HP UD ® hpud.4.2.CFGMO1M.extractor(ORA).config
® hpud.CFGMO01M.extractor(ORA).config
® hpud.extractor(MSSQL).config

® hpud.extractor(ORA).config,
hpud.schema_name.extractor(ORA).config

® hpud.schema_name.trial.extractor(ORA).config
® hpud.trial.extractor(MSSQL).config

® hpud.trial.extractor(ORA).config

ILMT ® ilmt.extractor (DB2).config

® ilmt.trial.extractor (DB2).config

MAP ®  map.full.extractor.config
® map.light.extractor.config
® map.trial.extractor.config
®  map8.extractor (MSS).config

® map8.trial.extractor (MSS).config

RADIA ® radia.extractor (MSSQL).config

® radia.trial.extractor (MSSQL).config

TAD4D ® tad4d.extractor (DB2).config

TAD4Z ® tad4d.trial.extractor (DB2).config
® tad4z.extractor (DB2).config

® tad4z.trial.extractor (DB2).config

TADDM ® taddm.extractor (DB2).config

® taddm.trial.extractor (DB2).config

TIVOLI ® tivoli.tcm.extractor(MSS).config
® tivoli.tcm.extractor(ORA).config
® tivoli.trial.tcm.extractor(MSS).config

® tivoli.trial.tcm.extractor(ORA).config)

Task To modify a 4.x custom configuration file:
1. Change the loader config value to “disc5_nonNumeric_loader_config_2015":

<?xml version="1.0" encoding="utf-8" ?>
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<configuration LoaderConfig="disc5_nonNumeric_loader_config 2015" Disc_Source="TCM">

2. Search for <Table Type="GUID"> in extractor config and interchange column names for Resource ID and GUID.
a. When GUID query is present in extractor config:
Before change to file:

<Table Type="GUID">

<SQL>
<! [CDATA[
SELECT
ROW_NUMBER() OVER (ORDER BY HOST_NODE_1.CMDB_ID) as ResourcelD,
TO_CHAR(rawtohex(HOST_NODE_1.CMDB_ID)) as GUID
FROM HOST_NODE_1
11>
</SQL>
</Table>

After change to file:

<Table Type="GUID">

<SQL>
<! [CDATA[
SELECT
TO_CHAR(rawtohex(HOST_NODE_1.CMDB_ID)) as ResourcelD,
ROW_NUMBER() OVER (ORDER BY HOST_NODE_1.CMDB_ID) as GUID
FROM HOST_NODE_1
1>
</SQL>
</Table>

b. When GUID query is not present in extractor config, add GUID query to extractor config so that a unique string
such as GUID is used as Resource ID, and Row Number sequence is used as GUID.

<Table Type="GUID">

<SQL>
<! [CDATA[
SELECT
TO_CHAR(rawtohex (HOST_NODE_1.CMDB_ID)) as ResourcelD,
ROW_NUMBER() OVER (ORDER BY HOST_NODE_1.CMDB_ID) as GUID
FROM HOST_NODE_1
11>
</SQL>
</Table>

3. Inallother extractor config queries:

a. Modify the remaining queries in extractor config by utilizing the Resource ID expression from GUID query as
ResourcelD in other queries.

b. Remove Row Number expression from all extractor queries except GUID query.
In the example below, note the change in Resource ID column and removal of Row Number function.
Before change to file:

<Table Type="System">
<SQL>
<! [CDATA[
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SELECT DISTINCT
comp.ResourceID as ResourcelD,
null as AD_Site,
null as User_Domain,
null as User_Name,
COMPUTER_ALIAS as Name,
null as Domain,
1 as Active,
0 as Obsolete

FROM dbo.COMPUTER_VIEW main

INNER JOIN
(SELECT DISTINCT
row_number() over (order by COMPUTER_SYS_ID) as ResourcelD,

COMPUTER_SYS_ID as GUID
FROM dbo.COMPUTER_VIEW) comp ON comp.GUID = main.COMPUTER SYS_ID
11>
</SQL>
</Table>
After change to file:
<Table Type="System">
<SQL>
<! [CDATA[
SELECT DISTINCT
COMPUTER_SYS_ID as ResourcelD,
null as AD_Site,
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Integrating the HP Data Flow Probe
Server

This appendix provides detailed information about integrating the Hewlett-Packard Universal Discovery (HPUD) agent-
based discovery solution with the Normalize component of the BDNA Data Platform. The integration enables you to
normalize the output of the HP Data Flow Probe Server using the data contained within the BDNA Technopedia catalog,
rather than the HP Universal Discovery Software Application Library. The HP scan file output (.xsf) is processed by
Normalize and stored in a file directory on the HP Probe Server. The file directory is “watched” by the HP Probe Server,
which is configured to retrieve the .xsf file and send it to the HP UCMDB (Universal Content Management Database).

Typically, the BDNA Data Platform Server is installed directly on the same system as the HP Data Flow Probe Server.

BDNA Data Platform and HP Data Flow Probe Server 10.21 are required for this integration.

HP Data Flow Probe Server Integration

Typically, the BDNA Data Platform Server is installed directly on the same system as the HP Data Flow Probe Server.

BDNA Data Platform and HP Data Flow Probe Server 10.21 are required for this integration.

Hardware Specifications

BDNA Data Platform Supported Hardware shows the hardware specifications for the BDNA Data Platform. The Database
Server specifications are especially relevant to integrating the HPUD solution, rather than the specifications for the Data
Platform Server and the User Console Server. This happens because the application servers and the database server are
located on the same system in the recommended configuration. For storage, you should estimate one megabyte per scan
file of additional storage requirements.

Itis essential to consider the CPU, storage, and memory requirements for BDNA Normalize, in addition to the existing CPU,
storage, and memory requirements of the HP Data Flow Probe Server, as shown in HP Universal CMDB 10.21 Supported
Hardware.

The Normalize specifications for sizing are also shown in BDNA Data Platform Supported Hardware. For an accurate
comparison, you should replace BDNA “devices” with HP “scan files” (as shown in Additional Data Flow Probe Hardware
Requirements), and use this as the suggested hardware requirement for the HP Probe Server with BDNA Normalize.
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Table F-14 « BDNA Data Platform Supported Hardware

Environment

Data Platform Server

User Console Server

Database Server

Small ® (CPU:Xeon ES-2630 or ® (CPU:Xeon ES-2630 or ® (CPU:Xeon ES-2630 or
(up to 2,000 similar, 2 cores similar, 2 cores similar, 2 cores
H a
devices) ® RAM:4GB ® RAM:8GB ® RAM:16GB
® Storage capacity: 20 GB ® Storage capacity: 20 GB ® Storage capacity: 50 GB
free space free space free space
® Network connection: ® Network connection: ® Network connection:
Gigabit Gigabit Gigabit
® Disk1/0: 80 MB/sec ® Disk1/0: 80 MB/sec ® Disk1/0:80 MB/sec
Medium ® CPU: Xeon ES-2630 or ® CPU: Xeon ES-2630 or ® CPU: Xeon ES-2630 or
(up to 50,000 similar, 4 cores similar, 4 cores similar, 4 cores
devi
evices) e RAM:8GB e RAM:16GB e RAM:32GB
®  Storage capacity: 100 GB ®  Storage capacity: 100 GB ®  Storage capacity: 350 GB
free space free space free space
® Network connection: ®  Network connection: ®  Network connection:
Gigabit Gigabit Gigabit
® Disk1/0: 80 MB/sec ® Disk1/0:80 MB/sec ® Disk1/0: 150 MB/sec
Large ® CPU:Xeon ES-2630 or ® CPU:Xeon ES-2630 or ® CPU:Xeon ES-2630 or
(up to 300,000 similar, 8 cores similar, 8 cores similar, 8 cores
devi
evices) e RAM:16GB e RAM:32GB e RAM:64GB
® Storage capacity: 200 GB ® Storage capacity: 200 GB ® Storage capacity: 1.5TB
free space free space free space
® Network connection: ® Network connection: ® Network connection:
Gigabit Gigabit Gigabit
® Disk1/0: 80 MB/sec ® Disk1/0:80 MB/sec ® Disk1/0:250 MB/sec

a.According to HP, a small deployment is less than 7000 assets, while BDNA characterizes a small deployment

as less than 2000 assets. Note the disk discrepancy on the HP Probe Server hardware disk space for enterprise

(75,000 assets) of 300 GB vs. BDNA’s 1.5 TB.
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Table F-15 « HP Universal CMDB 10.21 Supported Hardware

Component Requirement

Computer/Processor Windows/Linux:
To fulfill the CPU requirements, you must have one of the following:
® Intel Dual Core Xeon Processor 2.4 GHz or later
® AMD Opteron Dual Core Processor 2.4 GHz or later
Recommended: The latest generation of Intel/AMD processors are recommended.

In addition to the above requirements, you must have the following number of CPU Cores,
depending on your deployment configuration.

CPU Cores:

Deployment Minimum Recommended
Small 2 Cores 4 Cores
Standard 4 Cores 8 Cores
Enterprise 8 Cores 24 Cores

Note: As HP Universal CMDB performance is dependent upon processor speed, to ensure
proper HP Universal CMDB performance, it is recommended that you use the fastest possible

processor speed.

Memory Deployment Windows
Minimum Recommended

Small 4 GB RAM 8 GB RAM

Standard 8 GB RAM 16 GB RAM

Enterprise 16 GB RAM 32 GB RAM (for more than 40

million Cls and relationships)

Memory Swap File Windows: The virtual memory for Windows should be at least 1.5 times the size of the physical

memory.

Linux: The Linux swap file size should be equal in size to the physical memory.

Free hard disk space ® Small/Standard/Enterprise: At least 100 GB (for logs, memory dumps, and so on)
® |[fthe search functionality is enabled, more hard disk space is required.
For example,

® 4MCls + relationships: 30G or more space would be needed for SOLR
index files

® 20MCls + relationships: Almost 50G space would be needed

Display Windows: Color palette setting of at least 256 colors (recommended: 32,000 colors)
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Table F-15 « HP Universal CMDB 10.21 Supported Hardware

Component Requirement

Note: The hardware requirements for HP Universal CMDB Configuration Manager are the same as those for Universal CMDB.

Table F-16 « Additional Data Flow Probe Hardware Requirements

Component Requirement

Computer/processor Recommended: The latest generation of Intel/AMD processors (Intel Xeon CPUs or
compatible) and the fastest possible processor speed.

CPU Cores:

Deployment Minimum Recommended
Small 4 Cores 8 Cores
Standard 4 Cores 8 Cores
Enterprise 8 Cores 24 Cores

Note: As HP Universal CMDB performance is dependent upon processor speed in order to
ensure proper HP Universal CMDB performance it is recommended that you use the fastest
possible processor speed.

Memory Deployment Windows
Minimum Recommended
Small 4 GB RAM 8 GB RAM
Standard 8 GB RAM 16 GB RAM
Enterprise 12 GB RAM 24 GB RAM
Memory Swap File Windows: The virtual memory for Windows should be at least 1.5 times the size of the physical
memory.
Free hard disk space ® Small/Standard: 100 GB (Note: 75 out of 100 GB disk space is required for scan files
storage)

® Enterprise: 300 GB (Note: 225 out of 300 GB disk space is required for scan files storage)

Display Windows: Color palette setting of at least 256 colors (32,000 colors recommended)
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Table F-16 « Additional Data Flow Probe Hardware Requirements

Component Requirement

Note:

® ASmall Deployment supports a biweekly scanner-based inventory of 7500 nodes or a daily discovery of 5000 nodes for
application dependency mapping. Other combinations of scanner-based inventory nodes and application
dependency mapping discovery nodes are also supported, according to the following formula: [The number of
Inventory Discovery nodes] + 5 times [the number of application dependency mapping nodes] is less than or equal to
7500.

® AStandard Deployment supports a biweekly scanner-based inventory of 25,000 nodes or a daily discovery of 5000
nodes for application dependency mapping. Other combinations of scanner-based inventory nodes and application
dependency mapping discovery nodes are also supported, according to the following formula: [The number of
Inventory Discovery nodes] + 5 times [the number of application dependency mapping nodes] is less than or equal to
25,000.

® An Enterprise Deployment supports a biweekly scanner-based inventory of 75,000 nodes or a daily discovery of 10,000
nodes for application dependency mapping. Other combinations of scanner-based inventory nodes and application
dependency mapping discovery nodes are also supported, according to the following formula: [The number of
Inventory Discovery nodes] + 7.5 times [the number of application dependency mapping nodes] is less than or equal to
75,000.

® Forexample, 15,000 inventory discovery nodes and 2000 application dependency mapping nodes, in a Standard
deployment, would be supported.

® The XML Enricher must be configured to match the deployment mode of the probe. For details, see the “How to
Configure XML Enricher to Suit the Probe Deployment Mode” section in the HP Universal CMDB Data Flow Management
Guide.

Software Specifications

BDNA Normalize does not support all of the operating systems supported by the HP Probe Server (i.e., Linux).

Table F-17 « BDNA Data Platform Supported Software
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Operating Systems

® Windows
Server 2012
R2TM

® Windows
Server 2016
RZTM

Databases

MS SQL Server 2012™

(Standard Edition)

Browsers

® Windows Internet
Explorer™v11

® Google Chrome™ v44 or

® Mozilla Firefox™ v37 or

MS SQL Server 2014™

(Enterprise and Standard later
Editions)

MS SQL Server 2016™ later

(Enterprise and Standard

Editions)

Oracle 11gR2 Enterprise

Edition™

Oracle 12c Enterprise

Edition™

Hardware Platform

OS Type

Table F-18 « HP Universal CMDB 10.21 Supported Operating Systems

0S Version and
Edition

Supported

Recommended

x86-64 Windows Server2012  Datacenter and Yes Yes
R2 Standard, 64-bit
x86-64 Windows Server 2012  Datacenter and Yes Yes
Standard, 64-bit
x86-64 Windows Server2008  Enterprise SP2, R2, Yes
and R2 SP1 64-bit
x86-64 Windows Server 2008  Standard R2 and R2 Yes
SP1, 64-bit
x86-64 Red Hat Linux Server ~ Enterprise/Advanced  Yes
5.X 64-bit
x86-64 Red Hat Enterprise 64-bit Yes
Linux Server6.2,6.3,
6.4,and 6.5
x86-64 Oracle Enterprise Enterprise/ Yes

Linux Server with Red
Hat Compatible
Kernel v6.3,v6.4, and
V6.5

Advanced64-bit
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Table F-18 « HP Universal CMDB 10.21 Supported Operating Systems

0S Version and

Hardware Platform 0S Type Edition Supported Recommended
x86-64 Oracle Enterprise Enterprise/ Yes

Linux Server with Advanced64-bit

Unbreakable

Enterprise Kernel
v6.3,v6.4,and v6.5

x86-64 Windows Server 2003 No

x86 Windows Server 2008 No

Any SUSE Linux Server 9, Enterprise No
10,11

Sun SPARC Solaris 8,9, or 10 No

Any Red Hat Linux Server  Enterprise No
3,4

Itanium 64 Windows Server 2008 No

Itanium64 Red Hat LinuxServer5  Enterprise/Advanced No

Note « Note the following regarding HP Universal:

® All operating systems supported for Universal CMDB are also supported for HP Universal CMDB
Configuration Manager.

® Unsupported configurations are listed to ensure that there is no ambiguity on the scope of the Support
Matrix.

® TJostart the HP Universal CMDB Configuration Manager installer on Windows 2012, you must use one of the
following methods:

®  Openacommand prompt window and run the command HP_CM.10.20.exe i GUI.

® Right-click the installer and select Properties. Open the Compatibility tab and select Run this program
in compatibility mode for Windows 7.

® Windows Server 2003 is no longer supported as of UCMDB 10.01.

® Installation of HP Universal CMDB is not supported on 32-bit machines.

Note « Note: HP Probe Server supports Linux OS. Normalize does not.

HP UCMDB 10.20 Release Note

The following excerpt is from the HP UCMDB 10.20 Release Note: “Make sure that the server running the Data Flow Probe
meets the combined set of hardware requirements for both the Data Flow Probe and BDNA Normalize. For more detailed
information about the Data Flow Probe hardware requirements, see the HP Universal CMDB Support Matrix document. For
details about the BDNA Normalize hardware requirements, refer to the BDNA Normalize documentation.”
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HP What’s New Announcement

The following excerpt is from the HP “What’s New” announcement with version 10.20: “You may want to consider the extra
hardware requirements if you plan to install BDNA Normalize on the same machine as the HP Probe. For more detailed
information, refer to the BDNA Normalize documentation.”

HP Data Flow Probe Server Configuration

Prior to installing the BDNA Normalize server, the HP Data Flow Probe Server must be configured to bypass its default XML
Enricher and to use Normalize instead in order to normalize and/or enrich the .xsf scan files (DataFlowProbe.properties).
The HP Data Flow Probe Server 10.20 is a prerequisite. To do this you need to edit the DataFlowProbe.properties file and
set the value for com.hp.ucmdb.discovery.probe.agents.probemgr.xmlenricher.external.application.recognition=true.

This information is detailed in the HP document, Data Flow Management Guide, which is available on the HP support
portal. For your convenience, they are available in the section included in this document.

Figure F-113: Data FlowProbe.Properties

Bl bataFlowProbe.properties - Notepad
File Edt Format View Help

##5can &
# xml-enricher folder

#com. hp. ucmdb. discovery. inventory. scanners. xmlenricher. Tocation=xmlenricher

# xml-files location

#com. hp. ucmdb. discovery. inventory. scanners. xmlenricher. Tocation. files=5cans

# xml enricher system cleanup interval time millisecond, orphan days, 1egac¥ dags. expiration days

com. hp. ucmdb. discovery. inventory, scanners. xmlenricher. systemcleanup. interva’l=3600000

com. hp. ucmdb. discovery. inventory. scanners.xmlenricher. systemcleanup. orphan=40

com. hp. ucmdb. discovery. inventory. scanners.xmlenr icher. systemcleanup. Tegacy=7

com. hp. ucmdb. discovery. inventory. scanners. xmlenricher. systemcleanup. unrecognizedrileExpirationTime = 30
#s1eep time for monitor thread

com. hp. ucmdb. discovery. inventory. scanners.monitorthread. s 1eepTime=5000

#m1 Enricher parameters

com. hp. ucmdb. discovery. probe. agents. probemgr.xmlenricher. location. health=health

com. hp. ucmdb. discovery. probe. agents. probemgr.xanlenr icher. servicename=ucMps_Probe_m1enricher

# Enricher needs lots of time for big scanfiles - 15 mins

com. hp.ucmdb. discovery. probe. agents. probemgr.xmlenricher. healthfileTolerance=200000

com. hp. ucmdb. discovery. probe. agents. probemgr.xmlenricher.healthFileMmonitorInterval=60000

com. hp. ucmdb. discovery. probe. agents. probemgr . xnlenr icher. jmxport=34545

#This folder created under runtime folder and will contain temporary downloaded files

#each File will be placed under folder named by job which stores temporary file.
com.hﬁ.ucmdb.d1scover‘y.Erobe.agents.probemgr.tempdomTaad-TempDom'Iuad

#whether enable external application recognition

com. hp. ucmdb. discovery. probe. agents. probemgr. xmlenricher. external. application. recognition=trug|

#Turn on the debug mode for external apEHcatiDn recoﬁn'it'ion once enabled all the files in the processedcore folder will als
com. hp. ucmdb. discovery. probe. agents. probemgr. xmlenricher.external. application.recognition. debug=false

#minimal classpath required in order to execute basic discovery: IP_Ranges_By_ICMP, Host Connection by xxx, Host Resources b
#In order to use it one have to defined discovery job to run in separaté process and customize parameter ‘remotelvMClasspath
basic_discovery_minimal_classpath=../classes/;../conf;../1ib/app-infra.jar;../Tib/bcprov-jdkls. jar;../1ib/cmdb-framework. jar
ar;../1ib/normalization, q'ar'; .1k Mwem. Jar; . . /Tib/Twerypto, jar; .. /1ib/lwssoimpl. jar; . ./'I'lb/'lwssoutﬂs.jlar‘; .. /1ib/mysgl-conn
tent_15.jar;.. /content /1ib/discovery-content_14. jar;. ./)c/untem:/i‘ib/d'lsccvery-ccntem:_lB.jar: .. //content /1ib/discovery-content.

#normalization rules cache size per file. use '0’ for no cache.
com. hp. ucmdb. normalization. rules. cachesizeperfile=2000

#files with these extensions should be processed by dosZunix procedure when probe runs in “nix machine
dos2unix. file. extensions=cfg,conf,csv,dtd,groovy,ini,xml,properties,py,sh,sql,txt,x1s,x1sx,xml,xsd,xs1,xs1t

|3 ]

Using the Normalize Silent Installer

172

You can use the silent installer available in Normalize to install Normalize on the HP Data Flow Probe Server. The silent
install is detailed in the Normalize_CLI_API_Reference_Guide, which is available on the BDNA Support Portal. This
document details the various switches available during installation, such as overriding the default installation directory
(i.e., /PATH="D:\BDNA\Normalize”).

When you run the silent installer, you can include a configuration file to create the database and load the catalog in BDNA
Normalize.
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In the directory you downloaded the BDNA Normalize installer issue this command from a Windows command line prompt
(ensure you are running the command line prompt as Administrator).

Data Platform 550 4089 x64.exe /S /
WIZARDCONFIG="E:\Path\to\installc

. Administrator, Command Prompt M

isyod Data_Platform_558_4889_x64

“Data_Platform_558_488% x64>Data_Platform_550_4089 x64.exe -8 AWIZARDCONFIG=C: I
Data_Platform_558_4889_xb4vinstallconfig.config APATH="C:“BDNA“MNormalize"_

If you do not specify a /TYPE argument, the installation default is IIS Express and SQLServer Express.
The installer will attempt to install those prerequisites.

The download of SQLServer Express may fail due to a corporate firewall blocking the download. If this is the case, you can
manually copy the prerequisites to the server, then specify an offline location for the SQLServer Express installer. To do
this, specify a command line argument to the silent installer that you can then run manually. When you rerun the silent
installer, it will verify that those prerequisites are present. An example of the command follows:

SQLEXPR2014_x64 ENU.exe /ACTION=Install /FEATURES=SQLEngine /InstanceName=BDNANORMALIZE5@ /Q /
HIDECONSOLE /IAcceptSQLServerLicenseTerms /INSTALLSQLDATADIR="C:\Program Files\Microsoft SQL Server" /
TCPENABLED=1 /NPENABLED=1 /BROWSERSVCSTARTUPTYPE=Automatic /SQLSVCACCOUNT="NT AUTHORITY\SYSTEM"

A proxy may also time out while waiting for the silent installer to download the initial 1 GB catalog file. If this is the case,
you must copy the catalog to the server and specify that the silent installer should use that location with the following /
PKGPATH switch:

/PKGPATH="E: \Path\to\Catalog.zip”

After the prerequisites are downloaded and installed, the BDNA Normalize software is installed and the 1GB initial catalog
file is loaded. The BDNA Normalize install process is completed.
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:wod Data_Platform_558_4889_x64

wData_Platform_550_4889_ x64>Data_FPlatform_558_4088?_x64.exe ~5 ~WIZARDCOMFIG=C:
Data_Platform_558_488?_x64~installconfig.config #PATH="C:“~BDNA“MNormalize"

wData_Platform_550_4089_x64>

[2016.86.28 2@:43:881 info:

erifying if reguired % parameter is the first input parameter used to install
BDHNA Data Platform in silent mode

[2016.86.28 20:43:881 info:
hecking the parametersz filez path...

[2016.86.28 20:43:88] info:

Silent parameters: /5 SUHIZARDCOMFIG=C:“Data_Platform_5468_4889_ x64:installconfiyg.
onfig /PATH="C:“~BDHA“Hormalize"'

[2016.86.28 2@:43:881 info:
hecking operating system and BDHA Data Platform version...

[2016.86.28 20:43:881 info:
hecking operating system bit rate...

[2016.86.28 20:43:08] info:

In the sample installation configuration file provided in Example of a BDNA Normalize installconfig.config File, you will
need to update the company name and activation key with the company name and the BDNA Normalize key provided by
BDNA Support.

<CompanyName>PUT_YOUR_COMPANY_NAME_HERE</CompanyName>

<ActivationKey>PUT_YOUR_NORMALIZE_KEY_HERE</ActivationKey>

Running a Normalize Process

When the Normalize installation is finished, the HP Data Flow Probe server is configured to bypass the HP SAl enrichment
process and use the BDNA Normalize enrichment process in order to scan the output file using the BDNA Technopedia
Catalog. However, the HP Data Flow Probe Server is not set up to store the scan files indefinitely, so it is important to
schedule a Normalize process to run every 1-2 hours on the HP Data Flow Probe Server. As detailed in the HP
documentation below, there is a specific folder on the probe server in which the Normalize job should be configured in
order to retrieve scan files. It will also require a specific folder location in which to move new scan files.

Unlike Normalize jobs that pull from a database, you must use the Normalize Administration Console to create a Normalize
process that uses HP scan files (xsf).
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Task To run an HP Universal Discovery (.XSF) process in BDNA Normalize:

1.

2.

BDNA Data Platform 5.5

Create an HP Universal Discovery Process. (Refer to the BDNA Normalize Administrator Guide for detailed instructions

on creating and running a Normalize process.)

Figure F-114: Creating an HP Universal Discovery (.xsf) Process in BDNA Normalize

Process Type > IT Discovery Tool

Select IT Discovery Tool

Select a discovery tool you want to normalize.
() BDMA Discover
() BMC ADDM

() BMC BladeLogic Client Automation

() BMC BladeLogic Server Automation

() CAIT Client Manager (ITCM)

() CiscoWorks LAN Management Solution (LMS)

() Dell KACE

() HP Client Automation

() HP DDMi

) HP DDMa

() HP Server Automation

() HP Universal Discovery

(® HP Universal Discovery (XSF)

() IBM License Metric Tool

QO IBMTCM

() IBM Tivoli Application Dependency Discovery Manager

() LANDesk

() Lansweeper

oM g ft Enterprise Compliance Manager (ECM})
() Microsoft Assessment and Planning Toolkit (MAP) 7
() Microsoft Assessment and Planning Toolkit (MAP) &
() Microsoft SMS 2003

() Microsoft System Center Configuration Manager 2007
() Microsoft System Center Configuration Manager 2012
() Movell ZENworks

@ ocs

() Solarwinds Orion

() Scalable

() VMware vCenter Protect

() ServiceMow Discovery

() Other: Database Connection

() Other: Normalize Zip File

Specify the Input Folder in which to parse and update the .xsf file with normalized data. Also include the folder in

which you wish to move the updated scan files so they are sent to the UCMDB. Enter the following settings:

Input Folder:

<DataFlowProbeInstallDir>\runtime\xmlenricher\Scans\ProcessedNew directory

XSF Out:

<DataFlowProbeInstallDir>\runtime\xmlenricher\Scans\ProcessedCore directory

A batch size of 800 is recommended.

Figure F-115: Data Source and Output Specifications
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Details regarding the changes BDNA Normalize makes to the scan files can be found in the section, Understanding Scan
Files

Example of a BDNA Normalize installconfig.config File

<?xml version="1.0" encoding="utf-8"?>
<Configuration>
<CMDList>
<CommandLine>
<ErrorContinue>true</ErrorContinue>
<CMDName> <! [CDATA[${BMS_HOME}\Bin\NormalizeCMD.exe]]> </CMDName>
<Para><![CDATA[ -DEACTIVATENORMALIZECONSOLE]]> </Para>
</CommandLine>
<CommandLine>
<ErrorContinue>false</ErrorContinue>
<CMDName> <! [CDATA[${BMS_HOME}\Bin\NormalizeCMD.exe]]> </CMDName>
<Para><! [CDATA[ -SCHEDULEPROCESS /PROCESS_ID=1 /JSON="${BMS_HOME}\HPConf\Default_ SCHSync.json"]]>
</Para>
</CommandLine>
<CommandLine>
<API>ReplaceHPPara</API>
<ErrorContinue>false</ErrorContinue>
<CMDName> <! [CDATA[${BMS_HOME}\Bin\NormalizeCMD.exe]]> </CMDName>
<Para><![CDATA[ -CREATEPROCESS /PROCESS_TYPE=NORMALIZE /
JSON="${BMS_HOME }\HPConf\Default_XSFProcess.json"]]> </Para>
</CommandLine>
<CommandLine>
<ErrorContinue>false</ErrorContinue>
<CMDName> <! [CDATA[${BMS_HOME}\Bin\NormalizeCMD.exe]]> </CMDName>
<Para><![CDATA[ -SCHEDULEPROCESS /PROCESS_ID=10000 /JSON="${BMS_HOME }\HPConf\Default SCH.json"]]>
</Para>
</CommandLine>
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<CommandLine>
<ErrorContinue>false</ErrorContinue>
<CMDName> <! [CDATA[${BMS_HOME}\Bin\NormalizeCMD.exe]]> </CMDName>
<Para><![CDATA[ -runprocess /PROCESS_ID=10000]]> </Para>
</CommandLine>

</CMDList>

<StartMenu>true</StartMenu>
<OverwriteExistingDatabase>true</OverwriteExistingDatabase>
<CompanyName></CompanyName>

<ActivationKey></ActivationKey>
<TUSOffLineURL>http://tus50.bdna.com/GetOffLineUpdatedFile.aspx</TUSOffLineURL>
<NormalizeVersion>5.5.0</NormalizeVersion>

<InstallParameters>

BDNA Data Platform 5.5

<SerializableDictionary>
<key>
<string>Configuration/Normalize/NDB_DBConnection@type</string>
</key>
<value>
<string>DBConnectionSQLServer</string>
</value>
</SerializableDictionary>
<SerializableDictionary>
<key>
<string>Configuration/Normalize/PDB_DBConnection@type</string>
</key>
<value>
<string>DBConnectionSQLServer</string>
</value>
</SerializableDictionary>
<SerializableDictionary>
<key>
<string>Configuration/Normalize/NDBDBA_DBConnection@type</string>
</key>
<value>
<string>DBConnectionSQLServer</string>
</value>
</SerializableDictionary>
<SerializableDictionary>
<key>
<string>Configuration/Normalize/NDB_DBConnection</string>
</key>
<value>
<string>
<! [CDATA[
<ConnectionType>MsSqlServer</ConnectionType>
<Host>.\BDNANORMALIZE50</Host>
<User>BDNA</User>
<Password />
<Pooling>false</Pooling>
<MinPoolSize>@</MinPoolSize>
<MaxPoo0lSize>100</MaxPoolSize>
<ConnectionLifetime>30</ConnectionLifetime>
<Catalog>BDNA</Catalog>
<WindowsAuthentication>true</WindowsAuthentication>
<UseCurrentUser>true</UseCurrentUser>
<ConnectAsUser />

BDNA-AG_550 Company Confidential 177



Appendix F Integrating the HP Data Flow Probe Server
Running a Normalize Process

<ConnectAsPassword />
11>
</string>
</value>
</SerializableDictionary>
<SerializableDictionary>
<key>
<string>Configuration/Normalize/PDB_DBConnection</string>
</key>
<value>
<string>
<! [CDATA[
<ConnectionType>MsSqlServer</ConnectionType>
<Host>.\BDNANORMALIZES50</Host>
<User>BDNA_PUBLISH</User>
<Password />
<Pooling>false</Pooling>
<MinPoolSize>0</MinPoolSize>
<MaxPoolSize>100</MaxPoolSize>
<ConnectionLifetime>30</ConnectionLifetime>
<Catalog>BDNA_PUBLISH</Catalog>
<WindowsAuthentication>true</WindowsAuthentication>
<UseCurrentUser>true</UseCurrentUser>
<ConnectAsUser />
<ConnectAsPassword />
11>
</string>
</value>
</SerializableDictionary>
<SerializableDictionary>
<key>
<string>Configuration/Normalize/NDBDBA_DBConnection</string>
</key>
<value>
<string>
<! [CDATA[
<ConnectionType>MsSqlServer</ConnectionType>
<Host>.\BDNANORMALIZES50</Host>
<User />
<Password />
<Pooling>false</Pooling>
<MinPoolSize>0</MinPoolSize>
<MaxPoolSize>100</MaxPoolSize>
<ConnectionLifetime>30</ConnectionLifetime>
<Catalog>master</Catalog>
<WindowsAuthentication>true</WindowsAuthentication>
<UseCurrentUser>true</UseCurrentUser>
<ConnectAsUser />
<ConnectAsPassword />
11>
</string>
</value>
</SerializableDictionary>
<SerializableDictionary>
<key>
<string>Configuration/WebServer</string>
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</key>
<value>
<string>
<1 [CDATA[
<IISWEBSITE>Default Web Site</IISWEBSITE>
<PhysicalPath />
<TAPIAlisaName>bdna-api</TAPIAlisaName>
<TAPIAppPoolName>bdna-api</TAPIAppPoolName>
<AliasName>bdna-admin</AliasName>
<AppPoolName>bdna-admin</AppPoolName>
<IISType>IISEXPRESS</IISType>
<IsNativeIIS>false</IsNativeIIS>
<IISPort>8080</IISPort>
<State>NULL</State>
1P
</string>
</value>
</SerializableDictionary>
<SerializableDictionary>
<key>
<string>Configuration/LDAP</string>
</key>
<value>
<string>
<! [CDATA[
<ValueDict>
<key>
<string>UserName</string>
</key>
<value>
<string>DOMAIN\USERNAME</string>
</value>
<key>
<string>Password</string>
</key>
<value>
<string>ENTER_ENCRYPTED_PASSWORD_HERE</string>
</value>
<key>
<string>URL</string>
</key>
<value>
<string>LDAP/AD_SERVER:PORT</string>
</value>
<key>
<string>UserSearchFilter</string>
</key>
<value>
<string>(&amp; (objectClass=Person))</string>
</value>
<key>
<string>UserSearchBase</string>
</key>
<value>
<string>ou=0U_NAME, dc=DOMAIN_NAME, dc=DOMAIN_SUFFIX</string>
</value>
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<key>
<string>UserAttribute</string>
</key>
<value>
<string>sAMAccountName</string>
</value>
<key>
<string>ManagerDN</string>
</key>
<value>
<string>cn=USER_NAME, ou=0U_NAME , dc=DOMAIN_NAME,dc=DOMAIN_SUFFIX</string>
</value>
<key>
<string>Type</string>
</key>
<value>
<string>ActiveDirectory</string>
</value>
<key>
<string>GroupSearchFilter</string>
</key>
<value>
<string>(member={0})</string>
</value>
<key>
<string>AuthoritiesSearchBase</string>
</key>
<value>
<string>ou=0U_NAME ,dc=DOMAIN_NAME,dc=DOMAIN_SUFFIX</string>
</value>
<key>
<string>GroupSearchBase</string>
</key>
<value>
<string>ou=0U_NAME, dc=DOMAIN_NAME,dc=DOMAIN_SUFFIX</string>
</value>
<key>
<string>AuthoritiesSearchFilter</string>
</key>
<value>
<string>(&amp; (objectClass=group))</string>
</value>
<key>
<string>AuthoritiesRoleAtrribute</string>
</key>
<value>
<string>cn</string>
</value>
<key>
<string>GroupRoleAtrribute</string>
</key>
<value>
<string>cn</string>
</value>
<key>
<string>GroupIsSubtree</string>
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</key>
<value>
<string>True</string>
</value>
<key>
<string>GroupTestUser</string>
</key>
<value>
<string>Test_User_ Name</string>
</value>
</ValueDict>
<UserAuthentication>WA</UserAuthentication>
11>
</string>
</value>
</SerializableDictionary>
<SerializableDictionary>
<key>
<string>Configuration/AUTO_UPDATE_SOFTWARE</string>
</key>
<value>
<string>OFF</string>
</value>
</SerializableDictionary>
</InstallParameters>
</Configuration>

Relevant Contents of the HP Data Flow Management Guide

You can learn more by consulting the HP Data Flow Management Guide, which contains material that is relevant to the
BDNA Normalize integration.

Understanding Scan Files

Ascan file (referred to as an .xsf file) is a compressed format (i.e., gzip) of an xml file that an HP Universal Discovery agent
generates on a server or workstation. The file is populated with all of that machine’s hardware and software inventory
information. You can open a .xsf file with a tool such as winzip or winrar, and then open the .xml file contained inside for a
readable list of inventory information on the corresponding server (one .xsf file equals one machine).

A comparison of the Pre-BDNA Normalize and Post-BDNA Normalize .xsf files was performed in order to document the
changes BDNA makes to the scan file during normalization and prior to loading to the UCMDB. The results of the
comparison include:

® Inthe <hwOSWMISoftwareFeatureDescription> and <hwQOSServiceFileName> the file has quotes and apostrophes
encoded (i.e., &quot; instead of ).

® Thefile size is massively reduced after we run this process. i.e., the xml for Pre-Normalize files is 24mb and the xml for
Post is 1mb. This is a huge savings in terms of storage and UCMDB processing due to a smaller file size for 10,000 scan
files.
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® This happens because we strip out all of the <file> info from the Pre-Normalize files (all the xml tags for the dll,
exe files, etc.). We also strip out the Partially Recognized apps (<partialapp> tags).

® We put the normalized values into the application data section along with each normalized application within its own
application tag. <applicationdata><application>.
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® Wedo not change the OS installed applications (<hwOSInstalledApps_value> tag in the xsf).
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<hwdSServiceStartup type="attrib” val >Manual</hu0SServiceStartup> A <hw0SServiceStartup type="zttrib” value="1">Manual</hwdSServiceStartup> A
<hwdSServiceStatus type="attrit" value="1">Stopped</mi0SServiceStatus> <hw0SServiceStatus type="attrib" value="1">Stopped</hwdSserviceStatus>
</hw0SServices_values </hw0SServices_value>
<hwDSServices_value type="shell value"s <hu0SServices_value type="shell value"s
attrib”>AppToService_ipm monitor</hu0SServiceName> <hw0SServiceName type="attrib”>AppToService_ipm_monitor</mu0SServiceName
zttrib">AppToService ipm_monitor</hu0SServiceDisplayhanes <hw0sServiceDisplayNane type="zttrib”>AppToService ipm_monitor</huoSServiceDisplayName:
o | :\nrpe\bin\AppToService.exe” /sys "C:\nrpe\bin\ipn |& <hw0SServiceFileName type="attrib”>&quot;C:\nrpe\bin\AppToService. exelquat; [sys &quot;
attrib”>LocalSysten</hu0sServiceUser> <hw0SServiceUser type="attrib”>LocalSysten</huOSServicalsers
i s0un process</hudSServiceTypes <hw0SServiceType type="attrib" value="16">0un process</hwOSServiceTypes
sAutomatice/hu0SServiceStartups <hw0SServiceStartup type="sttrib" value="0">Autonatic</huOSServiceStartup>
<hwdSServiceStatus type="attrib" value="4">Running</m0SServiceStatus> <hw0SServiceStatus type="attrib” value="4">Running</hwDSServiceStatuss
</hw0SServices_value> </hw0SServices_value>
<hw0SServices_value type="shell value"s <hu0SServices_value type="shell value"s
<hwdSServicellane type="attrib">AppToService nrpeclient</hw0SServiceliane> <hw0SServiceName type="attrib”>AppToService nrpeclient</hw0SServiceNanes
<hwdSServiceDisplaylane type="zttrib">AppToService nrpeclient</m0SServiceDisplayName> <hw0SServiceDisplayNane type="zttrib">AppToService nrpeclient</hw0SServiceDisplayNare>
S <hwDSServiceFileName type="attrib">"C:\nrpe\bin\AspToService.exe” /sys "C:\nrpe\bin\arp | & <hw0SServiceFileName type="attrib">&quot;C:\nrpe\bin\AppToService. exeBquat; [sys &quot;
<hwdSServiceUser type="attrib">LocalSysten</hu0SServiceUser> <hw0SServiceUser type="attrib">LocalSysten</hwOSServicelsers
<hudSServiceType type="attrib" value="16">0un process</hu0SSzrviceTypes> <hw0SServiceType type="attrib" value="16">Oun process</hu0SServiceType>
<hwdSServiceStartup type="attrib" val >Automatic</hu0SServiceStartup> <hw0SServiceStartup type="sttrib" value="0">Automatic</hw0SServiceStartup>
<hwdSServiceStatus type="attrib" value="4">Running</m0SServiceStatus> <hw0SServiceStatus type="attrib" value="4">Running</hwdSServiceStatus>
</hw0sServices_value> </hw0SServices_value>
<hwdSServices_value type="shell value"> <hu0SServices_value type="shell value">
<hwdSServicelane type="attrib">aspnet_state</hw0SServicellane> <hw0SServicelame type="attrib">aspnet_state</hw0SServicellame>
<hwdSServiceDisplaylame type="cttrib">ASP.NET State Service</hw0SServiceDisplayName> <hw0$ServiceDisplaylame ty, ib">ASP.NZT State Service</hw0SServiceDisplaylame>
<hwdSServiceFileName type="attrib"»C:\WINDOWS\Microsoft.NET\ ramework\v4.d.3€319\aspnet <hw0sServiceFileName type="attrib">C:\WINDONS\Microsoft.NET\Framework\v4.0.30319\aspnet
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